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IntroductionIntroductionIntroductionIntroduction    

 
The Brunswick Vector Center Network System is a comprehensive automatic scoring and bowling center 
management system.  This system is designed to allow you to easily control and manage the operations of 
your bowling center. 
  
This manual is divided into the following sections: 
! Introduction 
! Management Functions - The management functions section provides information on setting up 

and managing the front desk or bowling control portion of the system. 
! Operational Functions - The operational functions section provides information on the features 

and operations of the bowling control or front desk portion of the system. 
! Point of Sale Management - The point of sale management section provides information on 

setting up and managing the point of sale portion of the system. 
! Point of Sale Operations - The point of sale operations section provides information on the 

features and operations of the point of sale terminals. 
! Scorer Functions - The scorer functions section provides information on the features and 

operations of the scorer 
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Service and SupportService and SupportService and SupportService and Support    
The following options are available for technical assistance with the Vector Center Network System: 
  
BY TELEPHONE: 

North America: 1-800-323-8141 
International: 001-231-725-4966 

  
BY FAX: 

North America: 1-231-725-4677 
International: 001-231-725-4677 

  
BY E-MAIL: 

crc@brunbowl.com 
  
BY MAIL: 

Brunswick Bowling and Billiards, Inc. 
525 West Laketon Avenue, Muskegon, MI 49441, USA 
  
or 
  
Contact your local distributor 
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Menus and Keyboard ShortcutsMenus and Keyboard ShortcutsMenus and Keyboard ShortcutsMenus and Keyboard Shortcuts    
MENUS 
File Service Settings Register Rental Change View 
Send Message 
CTRL-M 
  

Broken 
Lane/Hold 

Setup CTRL-S Member 
Register (F6) 

Open Play 
(F2) 

Practice Zoom 1:1 

Move Player 
CTRL-Y 

Machine 
Control (F8) 

Lane Settings 
CTRL-I 
  

Article 
Register 

Match Play 
(F7) 

Reservation Zoom 1:2 

Print (F3) Backup Pin Settings 
CTRL-K 

Statistics (F5) Waiting 
List (F9) 

Correct 
Scores (F11) 
CTRL-E 
  

Zoom 1:3 

Access Control Reboot Volume   Stop Lanes 
(ESC) 

Autostop 
Parameters 
CTRL-B 
  

  

Clerks GS Pinsetter 
Control 
  

Console 
Settings 

    Recover 
Lane 

  

Payment (F4) 
  

TV Control Red Head Pin 
Game 

    End Scorer 
Only 

  

Open Cash 
Drawer (F12) 
  

            

Update 
  

            

Exit (F10)             
  

  

KEYBOARD SHORTCUTS 
Control Key Combinations Function Keys 
CTRL - B 
Opens the Change Autostop function. 

F1 
Opens the main Help menu. 

CTRL - E 
Opens the Score Correction function. 

F2 
Opens the Open Play function. 

CTRL - F 
Opens the Change Finished Games function. 

F3 
Opens the main Print menu. 

CTRL - I 
Opens the Lane Settings function. 

F4 
Opens the Payment function. 

CTRL -K 
Opens the Pin Settings function. 

F5 
Opens the main Statistics menu. 
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CTRL - L 
Opens the Match Play menu. 

F6 
Opens the Membership Database. 

CTRL - M 
Opens the Message function. 

F7 
Opens the main League menu. 

CTRL - R 
Opens the Member Register function. 

F8 
Opens the Machine Control function. 

CTRL - S 
Opens the Setup function. 

F9 
Opens the Wait List function. 

CTRL - U 
Opens the Print Reports menu. 

F10 
Opens the Exit menu. 

CTRL - Y 
Opens the Move Players function. 

F11 
Opens the Score Correct function. 

  F12 
Opens the Cash Drawer for a "No Sale" 
transaction. 

  ESC key 
Opens the Stop Lanes function. 

  
Alternate Key Combinations   

ALT - F 
Opens the "File" menu. 

  

ALT - V 
Opens the "Service" menu. 

  

ALT - S 
Opens the "Settings" menu. 

  

ALT - R 
Opens the "Register" menu. 

  

ALT - E 
Opens the "Rental" menu. 

  

ALT - C 
Opens the "Change" menu. 

  

ALT - H 
Opens the "Help" menu. 
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Pin SettingsPin SettingsPin SettingsPin Settings    
Overview 
The Pin Settings function is used to control the operation of the Pinfall Camera. The Pinfall Camera is 
used to take a picture of the standing pins that is used to calculate the score.  The camera settings are very 
important for proper operation of the scoring system.  The score for each ball is determined by comparing 
the light level within a target with a threshold value.  If the light level inside the target is higher than the 
threshold value, the scorer will score a pin standing.  If the light level inside the target is lower than the 
threshold value, the scorer will score a pin bowled over.  The system has two light thresholds.  One that is 
set up for normal operation and one that is set up for operation in low light conditions such as black 
lights, or times when lights over the bowling lanes are turned off. 
  
PROCEDURES 
Camera Calibration: 

1. Turn on the pinsetters:  (This step may be omitted if the lanes are already in use or turned on.) 
1. Select the "Service" menu. 
2. Select the "Machine Control" menu item. 
3. Enter the lane or lane range to be calibrated 
4. Select the "Start" button 
5. If necessary, select the "Reset" button to cycle the pinsetter, so that a full rack of pins is 

standing. 
2. Setting the Pin Targets: 

1. Select the "Settings" menu. 
2. Select the "Pin Settings" menu item. 
3. Using the drop down menu, select the first lane to be calibrated. 
4. Using the mouse, drag the target for the headpin from the column at the right side of the 

dialog box to the head of the pin.  The number in the column on the right indicates the light 
level for that pin. 

5. Repeat the previous step for all pins.  Note: It is important to place the proper target on the 
proper pins so that the full screen and pop-up pin triangles display the proper results. 

3. Setting the initial Light Threshold: 
1. Temporarily place a pin target on the pit curtain (behind the pins) and make note of the light 

level for that pin target. 
2. Return the pin target selected in the previous step to its original location on the head of the 

pin. 
3. Select the "Level" field and enter a value midway between the lowest light level in the 

column on the right and the light level noted in step one. 
 
Note: The initial light level setting described is a good starting point for camera calibration.  The actual 
light level used may be varied from this setting to accommodate different lighting and pin conditions, 
such as colored pins. 
 

4. Setting the initial Night Light Threshold: 
1. Set the bowling center's lighting up as it would be used during night bowling events such as 

cosmic bowling, black light bowling or other reduced lighting conditions. 
2. Temporarily place a pin target on the pit curtain (behind the pins) and make note of the light 

level for that pin target. 
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3. Return the pin target selected in the previous step to its original location on the head of the 
pin. 

4. Select the "Level" field and enter a value midway between the lowest light level in the 
column on the right and the light level noted in step two.  This initial value us usually in the 
range of 100 to 150. 

 
Note: The initial light level setting described is a good starting point for camera calibration.  The actual 
light level used may be varied from this setting to accommodate different lighting and pin conditions, 
such as colored pins. 
 

5. Setting the Delay value: 
1. Select the delay field. 
2. Enter the amount of delay between the time that the rake or sweep is triggered and when the 

camera should take the picture for scoring.  This setting can be adjusted to capture late falling 
pins. 

6. When all camera settings have been made for this lane, select the "Save" button. 
 
Note: When finished setting the initial light level threshold in step four, it is recommended that the pins 
on the deck be knocked over.  Once this has been done, observe the light levels for each pin target to 
insure that there aren't any bright spots in the pin deck area that could cause a mis-score. 
  
DETAILS 
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The pinfall camera takes a black and white picture that is used for scoring.  This image is a grey-scale that 
ranges from black (a numeric value of 0) to white (a numeric value of 255), with various shades of grey in 
between.  Each pin has a small red target, where the camera is looking to determine whether or not that 
pin is standing.  In the picture displayed above, there is a numeric value on the right column that 
represents the amount of light seen by the system for each pin within that target.  This number is 
compared against the numeric value in the "Level" field.  When light level within a target is higher than 
the number in the "Level" field, the scorer will score that pin as standing.  When the light level within a 
target is lower than the number in the "Level" field the scorer will score that pin as bowled over.  The 
number in the "Level" field is entered for each lane.  This allows the scoring to be configured to the 
ambient light level on each lane, and the condition of the pins.  A good starting point is to set the value in 
the "Level" field at the midpoint between the light level of the pit curtain and the darkest pin.  Values 
between 80 and 100 are often used for bowling under regular light conditions.  There is usually quite a 
difference in these two values, and this allows the center to manipulate the values to accommodate 
variations in the light levels, without having to frequently reset this number. 
  
In some cases, the center has events where the light levels change dramatically.  Some examples include 
moonlight bowling events where lane lights are turned off or cosmic (blacklight) bowling.  In these cases 
a single light level may not offer enough variation to accommodate all lighting conditions.  As such, a 
second level field called "Night Bowling" can be configured to accommodate bowling in other lighting 
conditions.  In order to use the "Night Bowling Level" the "Night Bowling" option must be selected on 
the Scorer tab of the setup menu. 
  
Sometimes the light levels will be too high. For example, the pins should not all register 255, especially 
the back row. This causes the pins to lose their definition on the pin setting page, appear very bright, 
fuzzy on the edges and appear to balloon out. When this happens, the brightness should be adjusted on the 
video board of the lane computer so that the pins appear about as bright as the picture shown here.  
   
The "Delay" time, in milliseconds, controls when the scoring picture is taken.  The time starts once the 
rake/sweep has left the home position and the sweep switch has opened.   This value should be set to 
allow the rake/sweep to drop to the guard position before the picture is taken. The delay should end 
before the rack/table begins to move. 2500-3500 milliseconds is a typical setting for most pinsetters. This 
setting may vary from pinsetter to pinsetter. 
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VolumeVolumeVolumeVolume    
Overview 
The volume control is used to raise or lower the volume of the sounds played in conjunction with exciter 
graphics.  The volume level controls all lanes in the bowling center.  Volume cannot be controlled on an 
individual lane by lane basis. 
  

 
  
This volume control has no effect on the volume of the television display.  Television volume is 
controlled by the volume knob on the audio/video (A/V) control box.  This box is usually located at the 
front desk, near the video source and intercom handsets. 
  
PROCEDURES 
Increasing Exciter Sound Levels 

1. Select the Setup menu. 
2. Select the Volume menu item. 
3. Click on the pointer and slide the pointer up towards "Max" to increase the exciter sound volume 

on all lanes. 
4. Press the "OK" button when finished. 

Decreasing Exciter Sound Levels 
1. Select the Setup menu. 
2. Select the Volume menu item. 
3. Click on the pointer and slide the pointer down towards "Min" to decrease the exciter sound 

volume on all lanes. 
4. Press the "OK" button when finished. 
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Console SettingsConsole SettingsConsole SettingsConsole Settings    
Overview 
The console settings function is used to control various functions of the scorer.  These functions include 
setting the default language for each scorer, controlling the LCD Touchscreen screen saver, selecting 
which languages are available to the bowler at the scorer, and selecting which menu items are available to 
the bowler at the scorer. 
  
PROCEDURES 
Setting the Scorer's Default Language 

1. Select the "Settings" menu. 
2. Select the "Console Settings" menu item. 
3. Select the "Default Language" tab. 
4. Select the "Lane" field and enter the desired lane or lane range. 
5. Using the drop down menu, select the desired default language to be used when a lane is issued. 
6. Select the "OK" button. 
 

Enabling the LCD Touchscreen Screen saver 
1. Select the "Settings" menu. 
2. Select the "Console Settings" menu item. 
3. Select the "Default Language" tab. 
4. Place a checkmark in the Enable Screen Saver checkbox by clicking in the box. 
5. Select the "Activate Screen Saver" field and enter the number of minutes to wait before the screen 

saver is displayed after a lane is turned off. 
6. Select the "Move Logo Every" field and enter the number of seconds to wait before the screen 

saver image is moved on the screen. 
7. Select the "OK" button. 
 

Disabling the LCD Touchscreen Screen Saver 
1. Select the "Settings" menu. 
2. Select the "Console Settings" menu item. 
3. Select the "Default Language" tab. 
4. Remove the checkmark in the Enable Screen Saver checkbox by clicking in the box. 
5. Select the "OK" button. 
 

Controlling Scorer Languages 
1. Select the "Settings" menu. 
2. Select the "Console Settings" menu item. 
3. Select the "Available Languages" tab. 

 
To make a language available at the scorer: 
4. Place a checkmark in the small box in front of the desired language by clicking in the box. 
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To remove a language from the scorer: 
4. Remove the checkmark in the small box in front of the desired function by clicking in the box. 
5. Select the "OK" button. 

 
Note: Only eight of the available languages can be made available at the scorer at any time. 
  
Controlling Scorer Menu Items 

1. Select the "Settings" menu. 
2. Select the "Console Settings" menu item. 
3. Select the "Console Options" tab. 
4. Using the drop down menu, select the mode of play desired. 

 
To make a menu item available at the scorer: 
4. Place a checkmark in the small box in front of the desired menu item by clicking in the box. 
 
To remove a menu item from the scorer: 
4. Remove the checkmark in the small box in front of the desired menu item by clicking in the box. 
5. Select the "OK" button. 
 

DETAILS 
Default Language Tab 

 
  
This tab of the console settings is used to control which language is used by default when the lane is 
issued.  The operator can enter a single lane or a range of lanes when setting the default language. 
  
This tab is also used to control the screen saver that is displayed on the LCD Touchscreen.  The operator 
can enable or disable the screen saver display as well as setting how long it takes for the screen saver 
image to appear and how often the image should change location on the screen. 
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This tab is used to control which languages are available to the bowler at the scorer.  The system supports 
more languages than can be displayed within the menu structure at the scorer.  Therefore, a maximum of 
eight languages can be selected and available to the bowler.   
  

 
  
This tab is used to control which menu items are available to the bowler at the scorer.  Different menus 
can be set up for open play, cross lane open play and league play. 
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RebootRebootRebootReboot    
Overview 
The reboot function allows the score computers to be remotely rebooted.  Rebooting a computer will 
cause it to save all of its files, shut down and automatically restart.  Rebooting is a part of the suggested 
procedures for your system that should be performed on a daily basis. 
  

 
  
All scoring computers or a single scoring computer can be remotely rebooted.  Rebooting scoring 
computers may take as long as seven minutes.  There may be various displays visible on the automatic 
scorer while the scoring computer is rebooting. 
  
PROCEDURES 
Reboot All Scoring Computers 

1. Select the Service menu. 
2. Select the Reboot menu item. 
3. Select the "Reboot" button. 
 

Reboot A Single Scoring Computers 
1. Select the Service menu. 
2. Select the Reboot menu item. 
3. Using the drop down menu, select the scoring computer to be rebooted. 
4. Select the "Reboot" button. 
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Suggested ProceduresSuggested ProceduresSuggested ProceduresSuggested Procedures    
OVERVIEW 
This section describes procedures that should be routinely performed.   
  
PROCEDURES 
System Reboot 
This procedure restarts all of the computers on the network and should be performed on a daily basis, 
preferably prior to opening for business each day. 

1. Reboot each client computer: 
1. Exit the Vector program. 
2. Select the Window's Start button. 
3. Select the "Shut Down" menu item. 
4. Using the drop down menu, select the "Restart" menu item. 
5. Select the "OK" button. 
6. The computer will restart. 
7. Do NOT run the Vector program at this point. 

2. Reboot the Front Desk Server: 
1. At the Front Desk Server, select the "File" menu. 
2. Select the "Exit" menu item. 
3. Select the "Stop Server Tasks" option. 
4. Select the "OK" button. 
5. Select the Window's Start button. 
6. Select the "Shut Down" menu item. 
7. Using the drop down menu, select the "Restart" menu item. 
8. Select the "OK" button. 
9. The computer will restart. 
10. Run the Vector program. 

3. Reboot the scoring computers: 
1. From within the Vector program running on the Front Desk Server, select the "Service" 

menu. 
2. Select the "Reboot" menu item. 
3. Using the drop down menu, select "All" to reboot each scoring computer. 
4. Select the "OK" button. 
5. Select the "Yes" button to reboot the scoring computers. 

4. Restart Vector on each client computer. 
1. At each client, run the Vector program. 
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Lane StatusLane StatusLane StatusLane Status    
OVERVIEW 
The "Lane Status" display is the main view of the current and scheduled bowling center activities.  This 
display shows the status of the bowling lanes and a reservation summary that displays planned activities 
for the current day or any day selected using the perpetual calendar.  This display is also the central point 
for selecting other functions such as menu items or keystroke shortcuts. 
  
PROCEDURES 
Using Quick Postpaid Open Play 

1. Select a lane for postpaid open play by clicking or touching (if using a touch screen monitor) the 
green box under the lane number. 

 
Note: When turning a lane on in this manner, the lane will be issued in single lane open play mode with 
all of the system defaults.  If changes to these defaults or another type of bowling or payment is desired, 
don't use the "Quick Lane On" function, instead select the "Open Play" button at the bottom right of the 
display, or press the "F2" key on the keyboard. 
  
Making A Reservation 

1. Using the mouse or the touch screen, point to the starting time of the reservation on the desired 
lane or first lane of a lane range. 

2. Drag the pointer to the ending time on the desired lane or the last lane of a lane range.  When the 
mouse button is released or the finger lifted from the touch screen, the reservation dialog box will 
be automatically displayed. 

3. Select the "Name" field and enter the name of the party reserving the lane or lane range. 
4. If desired, select the "Remark" field and enter comments that can be viewed on the lane status 

page when the operator right clicks the reservation. 
5. Select the "Phone" field and enter the telephone number of the party reserving the lane or lane 

range, if desired. 
6. Select the "Fax" field and enter the fax number of the party reserving the lane or lane range, if 

desired. 
7. Select the "Address" field and enter the address of the party reserving the lane or lane range, if 

desired. 
8. To change the color code for this reservation, select the "Details" button and then click on the 

color code in the lower right corner.  Select the new color code for this reservation and select the 
"OK" button. 

9. To enter detailed information about this reservation, select the "Details" button and enter the text 
in the details field, then select the "OK" button. 

10. If the reservation is to repeat on a weekly basis, select the "Standing Until" option and enter the 
ending date of the reservation. 

11. Select the "OK" button to complete the reservation. 
 

Moving a Reservation 
1. Using the mouse, click on the reservation with the left or primary mouse button.  While holding 

down the left or primary mouse button drag the reservation to its new location. 
2. Select the "Yes" button to acknowledge the warning message. 
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Changing A Reservation 
1. Using the mouse, click on the reservation using the right or secondary mouse button. 
2. Select the "Properties" menu item from the pop up menu. 
3. Make desired changes. 
4. Select the "OK" button. 
 

Deleting A Reservation 
1. Using the mouse, click on the reservation using the right or secondary mouse button. 
2. Select the "Delete" menu item from the pop up menu. 
3. Select the "Yes" button to acknowledge the warning message. 
 

Changing the Date Of the Reservation Summary Display 
1. Select the "Tomorrow" radio button to view tomorrow's reservations, or 
2. Select the "+" button to increase the reservation calendar date by one day, or 
3. Select the "-" button to decrease the reservation calendar date by one day, or 
4. Select the "+7" button to increase the reservation calendar date by seven days, or 
5. Select the "-7" button to decrease the reservation calendar date by seven days, or 
6. Select the "Month", "Date" and "Year" fields and enter the desired month, date and year 

respectively. 
 

Viewing General Reservation Information 
1. Using the mouse, click on the reservation using the left or primary mouse button. 
2. View the reservation information in the lower left hand corner of the "Lane Status" display, 

where the Vector logo is normally displayed. 
 

Viewing Reservation Remarks 
1. Using the mouse, click on the reservation using the right or secondary mouse button. 
2. View the reservation remarks in the lower left hand corner of the "Lane Status" display, where 

the Vector logo is normally displayed. 
 

Issuing An Open Play Lane 
1. Using the mouse, click on the lane column for the desired lane under the green box using the right 

or secondary mouse button. 
2. Select the "Open Play" menu item. 
3. Select either the "Single Lane" or "Cross Lane" option.  Note:  Single Lane (open play) is 

selected by default. 
4. If desired, select either the "Time" or "Frames" practice option and then select the "Practice" field 

and enter the number of minutes for the lane or lane range or the number of frames of practice per 
bowler, depending on which practice option was selected.  If no practice is desired, set the value 
in the "Practice" field to zero. 

5. If desired, select the "Printer" drop down menu to select an automatic scoresheet printing option.  
The following options are available: 
! Game - When this option is selected scoresheets will be automatically printed at the end of 

each game.  This mode creates one printed page for each game bowled by a team or group of 
bowlers. 

! End - When this option is selected scoresheets will be automatically printed at the end of each 
series or match.  This mode creates one printed page for each match by bowler, unless the 
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"Print Bowlers On Separate Pages" option is selected, which will cause the system to print a 
separate page for each bowler. 

! None - When this option is selected scoresheets will not be automatically printed, but 
scoresheets will remain available for manual selection and printing up to seven days. 

6. If prepaid bowling is desired, enable the "Automatic Lanestop" option in the "Lane Shutdown" 
section.  The system defaults will be displayed.  To change these defaults: 
! Select either the "Time" or "Game(s)/Player" radio button for time bowling or game bowling 

respectively. 
! Select either the "Minutes" or "Games" field and enter the desired amount of time or number 

of games. 
7. In the "Names" section, select the "Lane" drop down menu to select the desired lane for name 

entry, if necessary.  If the transaction only involves a single lane, this step is not required. 
8. Select the "Number of Players" field and enter the number of names to be entered on the lane. 
9. Select the "Player Names" fields and enter the bowler's names.  If a bowler presents a 

membership card, the number can be entered and the name will be automatically loaded from the 
database.  Alternatively the bar code card can be scanned by the optional bar code reader, and the 
bowler name will be automatically loaded from the database.  If the membership card is not 
available, the database can be searched by pressing the plus button (+) on the keyboard.  Linking 
a lane transaction with a registered bowler name is required for bowler statistics to be generated. 

10. Select the "Mode" drop down menus and select the desired mode of bowling, if desired. 
11. Select the "Price Rate" drop down menus for each bowler and select the desired bowling article or 

price.  This option may not be available if it was turned off on the "Front Desk" tab of the "Setup" 
menu. 

12. If the center is equipped with automated bumpers and the ability to issue bumpers has been 
enabled on the "Front Desk" tab of the "Setup" menu, enable the bumpers for the desired bowlers 
by placing a checkmark in the "Bumper" check box. 

13. Select the "Birthday" checkbox to enable the special birthday exciter graphics, or leave the 
"Birthday" checkbox blank if the birthday exciters are not to be used.  NOTE:  The birthday 
graphics require the "Kids" multimedia set to be selected on the "Lane Settings" menu. 

14. Select the "Start" button to issue the lane.  If an autostop option was selected, the payment page 
may automatically be displayed at this point.  If the payment page is not selected, the operator 
must remember to manually select the payment page and make the appropriate payment.  
Alternatively, the "Reserve" button can be selected and this would create a lane reservation using 
the information entered above.  See also "Reservations" for more information. 

 
Sending A Message 

1. Using the mouse, click on the lane column for the desired lane under the green box using the right 
or secondary mouse button. 

2. Select the "Message" menu item. 
3. Select the type of message desired.  If "Full Text" is selected, the size, weight and font of the 

characters may be selected by pressing the font button. 
4. Enter the desired lane or lane range where the message is to be displayed. 
5. Select the "Display For" field and enter the number of seconds that the message is to be 

displayed, if the "Single Character" or "Full Screen Text" message type was selected. 
6. If the "Single Character" or "Full Screen Text" message type was selected, the "Interval" 

checkbox may be used to control whether or not the message will automatically be repeated at the 
interval entered in the "Minutes" field. 

7. Select the "Message Text" field and type the contents of the message. 
8. Select the "Add" button to save this message for future use, if desired. 
9. Select the "Ok" button to send the message with the selected settings to the lane. 
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Making A Lane Transfer 
1. Using the mouse, click on the lane column for the desired lane under the green box using the right 

or secondary mouse button. 
2. Select the "Move Player" menu item. 
3. Select the "To Lane" field and enter the new lane or lane range. 
4. Select the "Move" button and the entire lane is moved. 
 

Making a Score Correction 
1. Using the mouse, click on the lane column for the desired lane under the green box using the right 

or secondary mouse button. 
2. Select the "Correct..." menu item. 
3. Make desired changes. 
4. Select the "OK" button. 
 

DETAILS 

 
  
The menu items listed at the top of the page are used to access the various functions of the Vector system.  
See the "Menus and Keyboard" section in the introduction for more information. 
  
The "Lane Status" bar is used to display the status of the lanes.  The following colors are used to indicate 
the status of the lanes: 

! Green - Lanes Available 
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! Grey - Offline Lanes 

! Red - Rented Lanes (postpaid open play, league and tournament) 

! Scarlet - Rented Lanes with automatic lanestop after a certain time 

! Violet - Rented Lanes with automatic lanestop after a certain number of games 
 
The numbers in the colored square display information about the current session of bowling. The Frame 
row indicates the frame of the current game that is being bowled. The Game row indicates the current 
game or match number for the session. The Total row indicates the total number of frames bowled for the 
session. The Bowlers row indicates the number of bowlers currently bowling. Clicking the lane box for a 
lane that is off will turn the lane on in postpaid open play mode. Clicking the lane box for a lane that is on 
will begin the process of turning the lane off. 
  
The lane diagram also displays the red, scarlet, and violet squares, called Rental fields. These fields vary 
in size and show the duration of rented lanes. The height of the color bar shows how long the lane has 
been rented. Initially the bar will appear as a thin line, and will have a light red color  As it 
increases in size the box will change color to match the type of bowling that is in progress on that lane. To 
see exactly how long a lane has been rented click in the rental field and the requested information is 
displayed in the information panel in the lower left corner of the lane status page where the Vector logo is 
normally displayed. 
  

The default color for Reservations is light blue square , however the color of Reservation 
fields can be modified when a reservation is being made by clicking on the details button and selecting a 
new color. The reservation field may include the first two letters of the reservation name or the entire 
reservation name depending on the setting. Click on the reservation field and the information is displayed 
in the information panel in the lower left corner. Right-click a reservation to view any saved reservation 
remarks.  
  
The reservation summary for the today's date is displayed by default.  The date control can be used to 
select any date from the perpetual calendar.  The reservation summary will be displayed for the selected 
date.  The buttons can be used to move the date forward or backward by a day or week.  The reservation 
summary may automatically return to today's date after a short period of time, depending on the system 
settings. 
  
The function buttons in the lower right corner are used to directly access the listed functions.  These 
functions can also be accessed via the menus or keyboard shortcuts. 
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MessagesMessagesMessagesMessages    
OVERVIEW 
The system can be used to send messages to a lane or lane range.  The system supports the following 
three message types: 
! Full Screen Text - This message replaces the scoresheet with a full screen text message. 
! Single Character - This message sends one full screen size letter of the message to each lane 

selected. 
! Scrolling Banner - This message is displayed on the current scoresheet without obscuring the 

bowler's scores and the message scrolls across the message area of the scoresheet from right to 
left. 

Messages may be of a controlled duration and may automatically display repeatedly at a selected interval.  
Messages that are routinely used may be saved, so that they need not be re-typed each time. 
  
PROCEDURES 
Sending Messages 

1. Select the "File" menu. 
2. Select the "Send Message" menu item. 
3. Select the type of message desired.  If "Full Text" is selected, the size, weight and font of the 

characters may be selected by pressing the font button.  Note: It is recommended that you test the 
message after making changes to the font size and weights, since the size and shape of the 
message may change. 

4. Enter the desired lane or lane range where the message is to be displayed. 
5. Select the "Display For" field and enter the number of seconds that the message is to be 

displayed, if the "Single Character" or "Full Screen Text" message type was selected. 
6. If the "Single Character" or "Full Screen Text" message type was selected, the "Interval" 

checkbox may be used to control whether or not the message will automatically be repeated at the 
interval entered in the "Minutes" field. 

7. Select the "Message Text" field and type the contents of the message. 
8. Select the "Add" button to save this message for future use, if desired.  The first line of the 

message will be used as the message title when it is saved. 
9. Select the "Ok" button to send the message with the selected settings to the lane or lane range. 
 

Canceling Messages 
1. Select the "File" menu. 
2. Select the "Send Message" menu item. 
3. Enter the lane or lane range where the message is currently being displayed. 
4. Select the "Cancel Sent Message" button. 
 

Deleting Saved Messages 
1. Select the "File" menu. 
2. Select the "Send Message" menu item. 
3. Select the desired message title in the "Saved Messages" field. 
4. Select the "Remove" button. 
5. Select the "OK" button. 
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DETAILS 

 
  
Type Section 
This section allows the operator to select the type of message being sent to the lane or lane range.  The 
following message types are available: 
! Full Screen Text - This message replaces the scoresheet with a full screen text message. 
! Single Character - This message sends one full screen size letter of the message to each lane 

selected.  For example the message text "Hello" would be spread across five lanes with one letter 
being sent to each of the selected lanes.  If there is less text than lanes the remaining lanes will be 
blank. 

! Scrolling Banner - This message is displayed on the current scoresheet without obscuring the 
bowler's scores and the message scrolls across the message area of the scoresheet from right to 
left. 
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Font Button 

 
  
The "Font" button allows the operator to select the font to be used for "Full Screen Text" messages.  The 
font selection menu provides the following choices: 
! Font - The fonts listed in this box are those supported by the front desk computer.  All of the fonts 

listed at the front desk computer may not be available on the scoring computer. 
! Font Style - The following font styles are available: 
! Regular Text 
! Italic Text 
! Bold Text 
! Bold Italic Text 

! Font Size - The font's size may be set from 8 to 72 points. 
 
Message Options Section 
This section controls the options available for each type of message.  The following options are available: 
! "Send to All Lanes" - This checkbox allows the operator to send the message to all lanes without 

entering a lane range such as 1-40. 
! "To Lane" field - This field allows the operator to select where the message will be displayed.  

For example: 1-40; 1,3,5; 1-10,30 are all examples of the type of lane ranges that may be entered. 
! "Display For" field - this field allows the operator to enter the number of seconds that "Full 

Screen Text" and "Single Character" messages will be displayed.  At the end of this time the 
scoresheet will automatically return.  This option is not available for "Scrolling Banner" 
messages. 

! "Interval" - This checkbox controls whether or not the system will repeatedly display "Full Screen 
Text" and "Single Character" messages at the interval entered into the "Minutes" field.  This 
option is not available for "Scrolling Banner" messages. 

 
Message Text Field 
This field is used to enter the text that is to be sent to the lane as the message.  The same field is used for 
all message types. 
  
Saved Messages Field 
This field displays a list of messages that have been previously saved. 
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Lane TransfersLane TransfersLane TransfersLane Transfers    
OVERVIEW 
The Lane Transfer function is used to move bowlers or teams from one lane to another.  Usually lane 
transfers are necessary in case of a malfunctioning lane, but lane transfers can also be used to rotate lanes 
for special bowling events or to move specific bowlers from lane to lane. 
  
PROCEDURES 
Transferring Lanes 

1. Select the "File" menu. 
2. Select the "Move Player..." menu item. 
3. Select the "From Lane" field and enter the original lane or lane range. 
4. Select the "To Lane" field and enter the new lane or lane range.  Note:  The destination lane must 

be vacant. 
5. Select the "Move" button. 

 
Transferring Bowlers 

1. Select the "File" menu. 
2. Select the "Move Player..." menu item. 
3. Select the "From Lane" field and enter the original lane or lane range. 
4. Select the "To Lane" field and enter the new lane or lane range.  Note:  The destination lane must 

be in use. 
5. Select the "Advanced" button. 
6. Select the bowler to be moved and use the arrow buttons between the source and destination lanes 

to move the bowler's name. 
7. Use the "Up" and "Down" arrow buttons to place the bowler into the desired lineup position. 
8. Select the "Apply" button. 

 
Swapping Lanes 
This is a special type of lane transfer that is used to swap names between the selected lanes.  For example, 
if lane one and three are selected, the names from lane one will move to lane three, and the names from 
lane three will move to lane one.  This lane transfer method is often used with tournaments that use a 
"Flip-Flop" method of rotation. 

1. Select the "File" menu. 
2. Select the "Move Player..." menu item. 
3. Select the "From Lane" field and enter the first lane or lane range of an active lane. 
4. Select the "To Lane" field and enter the second lane or lane range of an active lane. 
5. Select the "Swap" button. 
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DETAILS 

 
  
The "From Lane" field is used to enter the original lane of a pending lane transfer, or one of the lanes in a 
lane swap. 
  
The "To Lane" field is used to enter the destination lane of a pending lane transfer or the second one of 
the lanes in a lane swap. 
  
The "Move" button is used to execute the lane transfer from the source lane or lane range entered in the 
"From Lane" field to the lane or lane range entered in the "To Lane" field. 
  
The "Swap' button is used to exchange or swap the bowler information from the lane entered in the "From 
Lane" field with the bowler information from the lane entered in the "To Lane" field. 
  
The "Advanced" button is used to expand the lane transfer display to allow bowler names to be 
transferred from lane to lane. 
  
The "Apply" button is used to execute the individual bowler lane transfer. 
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Exiting the ProgramExiting the ProgramExiting the ProgramExiting the Program    
OVERVIEW 
This function is used to end the Vector program and/or reboot the Vector computer.  The Vector program 
should be exited prior to shutting down the computer at the end of the business day.  It is recommended 
that each Vector computer be rebooted on a daily basis.  Rebooting helps to keep the system operating 
efficiently. 
  
PROCEDURES 
Exiting The Vector Program 

1. Select the "X" button in the upper right corner of the Vector Program. 
or 
1. Select the "File" menu. 
2. Select the "Exit" menu item. 
3. Select from the following options: 
! "Exit Front Desk" - This option exits the Vector program but does not end all Vector related 

services that may be running in the background. 
! "Stop Server Tasks" - This option exits the Vector program and ends all Vector related 

services that are running in the background. 
! "Reboot" - This option exits the Vector program, ends all Vector related services that are 

running in the background and causes the computer to reboot. 
4. Select the "OK" button. 

 
DETAILS 

 
  
The "Exit Front Desk" option is used to end the Vector program only.  This function is typically used of 
the Vector program is to be restarted.  When this option is selected the Vector program will be stopped, 
but other terminals may still access the databases on the server. 
  
The "Stop Server Tasks" option is used to end the Vector program as well as some small Vector related 
services that may be running as background tasks in the Window's operating system.  When this option is 
selected the Vector program will be stopped and other terminals will not be able to access the databases 
on the server, so it is important to stop Vector on all clients when this option is used. 
  
The "Reboot" option is used to end the Vector program, the Vector related services that may be running 
as background tasks in the Window's operating system and to reboot the computer. 
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PPPPrinting Scoresheetsrinting Scoresheetsrinting Scoresheetsrinting Scoresheets    
OVERVIEW 
This function is used to print bowler's scores.  There are a variety of scoresheet printing options available. 
  
PROCEDURES 

1. Select the "File" menu. 
2. Select the "Print" menu item. 
3. Select the "Games" menu item and select the "OK" button. 
4. Select the "Lanes" field and enter the desired lane or lane range to be printed. 
5. Select the desired sorting method for the scoresheet list.  The following options are available: 
! Team - By Assignment:  This selection displays the following scoresheet information: Lane 

Number, Scoresheet Date, Start and End Times, Total Frames Bowled. 
! Team - Game By Game:  This selection displays the following scoresheet information: Lane 

Number, Match or Game Number, Start Date and Time 
! Individual - By Assignment:  This selection displays the following scoresheet information: 

Bowler Name, Lane Number, Quantity of Games Bowled and Time. 
! Individual - Game By Game  This selection displays the following scoresheet information: 

Lane Number, Match or Game Number, Time, Bowler Name, Team Number and is sorted by 
one of the following selections: 
! Name - Sorts the scoresheets by bowler name. 
! Time - Sorts the scoresheets by time. 
! Lane - Sorts the scoresheets by lane number. 

6. Select the desired scoresheet by day range in the "Interval" section. 
7. Select the desired scoresheet options.  The following options are available: 
! Photos - This option will display the actual image used by the pinfall camera for scoring, if 

the "Save Camera Images" option was enabled on the "Scorer" tab of the system "Settings" 
menu.  Pinfall camera images are only available for today's scoresheets.  This option cannot 
be combined with any of the other scoresheet display options. 

! Pins - This option will display the actual standing pins after each delivery of the frame.  The 
pins marked with dots were bowled over on the first ball of the frame.  The pins marked with 
black pins were bowled over on the second ball of the frame.  The pins marked with white 
pins were not bowled over.  This option is an excellent learn to bowl tool. 

! Shadows - This option will display a shadow box below and to the right of the main 
scoresheet display. 

! Rates - This option will display the payment information for this lane transaction at the 
bottom of the scoresheet display.  This portion of the display will be blank prior to making a 
payment. 

8. Select the desired scoresheet or scoresheets by highlighting them on the scoresheet list. 
9. If desired, select the "Background Image" option and select the browse button to select the 

desired image to be placed as a watermark behind the scoresheet information. 
10. Select the "Preview" button to view the scoresheet on the monitor or select the "Print" button to 

print the scoresheet. 
 
DETAILS 
All scoresheets will display the "Header Text" and "Note Text" as entered on the print tab of the system 
"Settings".  Additionally, at the end of each scoresheet will be a sum of the scores on the scoresheet and 
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an average score for the scores on the scoresheet.  This is very helpful when running small tournaments or 
impromptu bowling activities. 
  
Scoresheet With No Options 
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Scoresheet With Pins (Pinfall Display) 
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Scoresheet With Shadows, Pins and Rate Information 
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Printing Membership CardsPrinting Membership CardsPrinting Membership CardsPrinting Membership Cards    
OVERVIEW 
This function is used to print Frequent Bowler Program Membership Cards.  These cards are not required 
by the system, since bowler information can be selected from the database by name or number in addition 
to scanning the bar coded card, however, they are a tool that promotes customer loyalty and can be used 
to prevent unauthorized use of another member's Frequent Bowler Program benefits. 
  
PROCEDURES 

1. Select the "File" menu. 
2. Select the "Print" menu item. 
3. Select the "Member Cards" menu item and select the "OK" button. 
4. Select the "Member Number" field and enter the member's number.  (This will cause the system 

to automatically fill in the remaining fields from the information stored in the Membership 
Database.  The "Period of Validity" date can be manually entered as well. 

5. Select the " Remark" field and enter comments to be printed on this card, if desired. 
6. Select the "Snap Pic" button to take the customer's picture using the optional Membership 

Camera, if desired.  Or, select the "Use Picture" option and select a picture from the hard drive.  
(This is typically used to select pictures that were scanned or taken with a stand alone digital 
camera. 

7. Select the "Preview" button to view the membership card on the monitor or select the "Print" 
button to print the membership card. 

 
DETAILS 
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Printing Barcodes for ClubsPrinting Barcodes for ClubsPrinting Barcodes for ClubsPrinting Barcodes for Clubs    
OVERVIEW 
This function is used to print a bar code list for members, selected by club affiliation.  This would allow 
quick and easy name entry for bowlers in a specific club that do not use a third party league program. 
  
PROCEDURES 

1. Select the "File" menu. 
2. Select the "Print" menu item. 
3. Select the "Barcodes for Club" menu item and select the "OK" button. 
4. Select the desired club or clubs. 
5. Select the "Preview" button to view the bar code list on the monitor or select the "Print" button to 

print the bar code list. 
 
DETAILS 
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Printing Barcodes for ArticlesPrinting Barcodes for ArticlesPrinting Barcodes for ArticlesPrinting Barcodes for Articles    
Overview 
This function is used to print a bar code list of articles or products, selected by article group.  This allows 
articles or products to be rung up using the bar code scanner.  Typically this function is used for products 
that don't have a bar code, such as open bowling. 
  
PROCEDURES 

1. Select the "File" menu. 
2. Select the "Print" menu item. 
3. Select the "Barcodes for Articles" menu item and select the "OK" button. 
4. Select the desired club or clubs. 
5. Select the "Preview" button to view the bar code list on the monitor or select the "Print" button to 

print the bar code list. 
 
DETAILS 
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Printing Membership Database ReportsPrinting Membership Database ReportsPrinting Membership Database ReportsPrinting Membership Database Reports    
OVERVIEW 
This function is used to print a variety of reports from the Membership Database. 
  
PROCEDURES 

1. Select the "File" menu. 
2. Select the "Print" menu item. 
3. Select the "Member Register" menu item and select the "OK" button. 
4. Select the desired report and select the "OK" button. 
5. Enter the variables for the report, if necessary. 
6. Select the "Preview" button to view the selected report on the monitor or select the "Print" button 

to print the selected report on the printer. 
 

DETAILS 
Alphabetical Locker Report 
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Alphabetical Membership Report 

 
 
  
Expired Lockers Report 
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Expired Memberships Report 

 
  
 
Mailing Labels Report 
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Members By Age Report 

 
  
 
Members By Average Report 
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Members By Gender Report 

 
  
Members Not Registered Since Report 
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Membership By Birth Month Report 

 
  
 
Membership Range Report 
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Membership Registration Form 

 
  
 
Valid Lockers Report 
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Valid Memberships Report 
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Printing Cash ReportsPrinting Cash ReportsPrinting Cash ReportsPrinting Cash Reports    
OVERVIEW 
This function is used to print a variety of cash reports. 
  
PROCEDURES 

1. Select the "File" menu. 
2. Select the "Print" menu item. 
3. Select the "Cash Report" menu item and select the "OK" button. 
4. Select the desired report and select the "OK" button. 
5. Enter the variables for the report, if necessary. 
6. Select the "Preview" button to view the selected report on the monitor or select the "Print" button 

to print the selected report on the printer. 
 
DETAILS 
Alphabetical Articles Report 
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Article Range Report 

 
  
 
Articles By Group Report 
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Cash Detail Report 

 
  
 
Cash Summary Report 
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Employee Productivity Report 

 
  
 
Hourly Productivity Report 
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Numerical Articles Report 

 
  
 
Refund Report 
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Transaction Log Report 

 
  
Transaction Range Report 
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Printing Frequent Bowler Program ReportsPrinting Frequent Bowler Program ReportsPrinting Frequent Bowler Program ReportsPrinting Frequent Bowler Program Reports    
OVERVIEW 
This function is used to print a variety of Frequent Bowler Program Reports. 
   
PROCEDURES 

1. Select the "File" menu. 
2. Select the "Print" menu item. 
3. Select the "FBP Reports" menu item and select the "OK" button. 
4. Select the desired report and select the "OK" button. 
5. Enter the variables for the report, if necessary. 
6. Select the "Preview" button to view the selected report on the monitor or select the "Print" button 

to print the selected report on the printer. 
 
DETAILS 
FBP History Report 
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FBP Paid Out Report 

 
  
 
FBP Settings Report 
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Printing ReservationsPrinting ReservationsPrinting ReservationsPrinting Reservations    
OVERVIEW 
This function is used to print text based or graphical reservation reports. 
  
PROCEDURES 

1. Select the "File" menu. 
2. Select the "Print" menu item. 
3. Select the "Print Reservations" menu item and select the "OK" button. 
4. Select either the graphical view or text based report option. 
5. Select the desired date. 
6. Select the "Preview" button to view the selected report on the monitor or select the "Print" button 

to print the selected report on the printer. 
 
DETAILS 
Graphical Reservation Report 
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Text Based Reservation Report 
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Broken Lane/HoldBroken Lane/HoldBroken Lane/HoldBroken Lane/Hold    
OVERVIEW 
This function is used to indicate that lanes are out of service or to place a lane that us currently issued to a 
customer on hold while a repair or other delay takes place.  When a time bowling lane is placed on hold 
the amount of time on hold is subtracted from the total amount due, so that the customer is not charged 
for the time on hold.  Lanes that are in use when this function is performed are put on hold, while lanes 
that are not in use when this function is performed are marked out of service or broken.  Lanes that are 
broken or on hold will be displayed on the main lane status page with a large red letter X through the lane 
column. 
  
PROCEDURES 
Placing A Lane On Hold 

1. Select the "Service" menu. 
2. Select the "Broken Lane/Hold..." menu item. 
3. Select the lane to be put on hold from the "Operational Lane" list. 
4. Select the "Right Arrows" button. 
5. Select the "Close" button. 

 
Removing A Lane From Hold 

1. Select the "Service" menu. 
2. Select the "Broken Lane/Hold..." menu item. 
3. Select the lane to be removed from hold from the "Lanes On Hold (Broken)" list. 
4. Select the "Left Arrows" button. 
5. Select the "Close" button. 
 

Marking A Lane Broken (Out Of Service) 
1. Select the "Service" menu. 
2. Select the "Broken Lane/Hold..." menu item. 
3. Select the lane to be put on hold from the "Operational Lane" list. 
4. Select the "Right Arrows" button. 
5. Select the "Close" button. 

 
Removing a Lane Broken (Out Of Service) indication 

1. Select the "Service" menu. 
2. Select the "Broken Lane/Hold..." menu item. 
3. Select the lane to be put on hold from the "Operational Lane" list. 
4. Select the "Right Arrows" button. 
5. Select the "Close" button. 

 



 63

DETAILS 

 
  
The "Operational Lanes" list displays the lanes are available for use, while the "Lanes On Hold (or 
Broken)" list displays the lanes that are not available for use.  Lanes that are not available for use are also 
displayed on the lane status page with a large red letter "x" in the lane column.  Lanes that are marked as 
broken or on hold can be issued if the warning message is acknowledged, therefor placing a lane on hold 
or marking it broken should not be used as a safety measure by the pinsetter mechanic. 
  
The left and right arrow buttons are used to move lanes between the "Operational Lanes" and "Lanes On 
Hold" lists. 
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Machine ControlMachine ControlMachine ControlMachine Control    
OVERVIEW 
This function is used to control the pinsetters without issuing the lanes.  Typically this is a function used 
by the pinsetter mechanic.  Common uses include turning on machines to set pin fall cameras, resetting 
pins after conditioning the lanes and turning lanes of for maintenance procedures.  Machine control 
functions can also be used on lanes that are issued.  For example, you may want to remotely press the 
reset button on a lane from the front desk. 
  
PROCEDURES 
Starting Pinsetters 

1. Select the "Service" menu. 
2. Select the "Machine Control" menu item. 
3. Enter the desired lane or lane range. 
4. Select the "Start" button. 

 
Resetting Pinsetters 

1. Select the "Service" menu. 
2. Select the "Machine Control" menu item. 
3. Enter the desired lane or lane range. 
4. Select the "Reset" button. 

 
Stopping Pinsetters 

1. Select the "Service" menu. 
2. Select the "Machine Control" menu item. 
3. Enter the desired lane or lane range. 
4. Select the "Stop" button. 

 
DETAILS 

 
  
The "Lane:" field is used to select which lanes will be affected. 
  
The "Start" button is used to turn on the pinsetters on the selected lanes. 
  
The "Stop" button is used to turn off the pinsetters on the selected lanes. 
  
The "Reset" button is used to cycle the pinsetters on the selected lanes.  The reset function is the same as 
the reset button found on the ball return. 
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GS Pinsetter ControlGS Pinsetter ControlGS Pinsetter ControlGS Pinsetter Control    
OVERVIEW 
This function is used to control GS pinsetters without issuing the lanes.  Typically this is a function used 
by the pinsetter mechanic.  Common uses include turning on machines, spotting specific pins and turning 
lanes of for maintenance procedures. 
  
PROCEDURES 
Starting GS Pinsetters 

1. Select the "Service" menu. 
2. Select the "GS Pinsetter Control" menu item. 
3. Enter the desired lane or lane range. 
4. Select the "Machine On" button. 

 
Stopping GS Pinsetters 

1. Select the "Service" menu. 
2. Select the "GS Pinsetter Control" menu item. 
3. Enter the desired lane or lane range. 
4. Select the "Machine Off" button. 

 
Turning GS Pinsetter Pin Deck Lamps On 

1. Select the "Service" menu. 
2. Select the "GS Pinsetter Control" menu item. 
3. Enter the desired lane or lane range. 
4. Select the "Pin Light On" button. 

 
Turning GS Pinsetter Pin Deck Lamps Off 

1. Select the "Service" menu. 
2. Select the "GS Pinsetter Control" menu item. 
3. Enter the desired lane or lane range. 
4. Select the "Pin Light Off" button. 

 
Spotting Pins 

1. Select the "Service" menu. 
2. Select the "GS Pinsetter Control" menu item. 
3. Enter the desired lane or lane range. 
4. Using the pin buttons 1-10, select which pins are to be standing. 
5. Select the "Set Pins" button. 

 
GS Pinsetter Spare Practice Mode 

1. Select the "Service" menu. 
2. Select the "GS Pinsetter Control" menu item. 
3. Enter the desired lane or lane range. 
4. Select the "Use Pattern For x Frames" field and enter the number of frames to set the selected 
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spare. 
5. Using the pin buttons 1-10, select which pins are to be standing. 
6. Select the "Set Pins" button. 

 
GS Pinsetter Emergency Off 

1. Select the "Service" menu. 
2. Select the "GS Pinsetter Control" menu item. 
3. Enter the desired lane or lane range. 
4. Select the "Emergency Off" button. 

 
DETAILS 

 
 
Pinsetter Commands Section 
This section is used to send commands to the GS pinsetter.  These commands may be used whether the 
lane is issued or not.  The following commands are available: 
! Machine On - This command will turn on the pinsetter for the selected lane or lane range. 
! Machine Off - This command will turn off the pinsetter for the selected lane or lane range.  

NOTE: Turning off GS pinsetters in this manner is not to be used in an emergency.  The pinsetter 
will complete it's current cycle prior to turning off.  If a pinsetter must be shut off in an 
emergency, then use the "Emergency Off" button. 

! Pin Light On - This command will turn on the pin deck lamp only for the selected lane or lane 
range. 

! Pin Light Off - This command will turn off the pin deck lamp only for the selected lane or lane 
range. 

! Foul Units On *- This command will turn on the foul units for the selected lane or lane range. 
! Foul Units Off * This command will turn off the foul units for the selected lane or lane range. 

*Foul unit control is only available in centers that have upgraded to Vector from BowlerVision or 
BowlerVision II. 
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Pin Pattern Section 
This section is used to control which pins the pinsetter spots.  Typically this function is used to respot 
pins during league or tournament competition.  Any pin combination can be set on any lane from the front 
desk.  This section can also be used to set up spare practice, by entering a number of frames other than 
zero in the "User Pattern for x Frames" field.  For example, if 8 is entered in the field, whatever pin 
combination is selected will be set for eight consecutive frames.  Pin selection can be made by pressing 
the button for a pin or by entering the pin number in the field at the bottom of this section.  The "Set Pins" 
button causes the system to set the specified pins for the desired number of frames. 
  
Settings Section 
This section is used to control various GS Pinsetter options.  The following options are available: 
! Automatic Fouls - This option controls whether or not the pinsetter will react to a foul signal from 

the foul detector.  If this option is enabled the pinsetter will set a new rack of pins and advance to 
the next ball cycle if a foul signal is sent by the foul detector.  If this option is disabled, foul 
signals will be ignored. 

! Automatic Set New Pins - This option controls whether or not the pinsetter will sweep the pin 
deck clear and set a new rack of pins every time the pinsetter is turned on. 

! Automatic POOR (Pin Out Of Range) - This option controls whether or not the pinsetter will 
require human intervention after a pin out of range.  If this option is selected the pinsetter will not 
require human intervention after a pin out of range.  If this option is not selected, the pinsetter 
will go into a jam state and blackout, requiring the mechanic to reset the pinsetter and the bowler 
to enter the pinfall data for scoring purposes.   
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Television ControlTelevision ControlTelevision ControlTelevision Control    
OVERVIEW 
The TV Control function is used to control the video display of the overhead monitors.  Overhead 
monitors can display the video signal provided to the Audio/Video (A/V) box or scoresheet information 
from the scorer.  Overhead monitors usually display advertising messages on lanes that are not being 
used, but these monitors can also be turned off. 
  
Additionally, some centers may be equipped with additional overhead monitors that are used only for 
video display.  These monitors may be placed in between the scoresheet monitors of a lane pair, or they 
may be placed between some or all lane pairs.  The TV Control function is used to configure these 
monitors and to turn these monitors on and off. 
  
PROCEDURES 
Displaying Scoresheets On the Overhead Monitors 

1. Select the "Service" menu. 
2. Select the "TV Control" menu item. 
3. Select the "Lane(s)" field and enter the desired lane or lane range. 
4. Select the "Scoring" button. 

 
Displaying Video On the Overhead Monitors 

1. Select the "Service" menu. 
2. Select the "TV Control" menu item. 
3. Select the "Lane(s)" field and enter the desired lane or lane range. 
4. Select the "Video" button. 

 
Turning Overhead Monitors Off 

1. Select the "Service" menu. 
2. Select the "TV Control" menu item. 
3. Select the "Lane(s)" field and enter the desired lane or lane range. 
4. Select the "OFF" button. 

 
Turning TV Only Monitors On 

1. Select the "Service" menu. 
2. Select the "TV Control" menu item. 
3. Select the desired TV Only monitor from the list by placing a checkmark in the box for the 

desired monitor. 
4. Select the "On" button. 

 
Turning TV Only Monitors Off 

1. Select the "Service" menu. 
2. Select the "TV Control" menu item. 
3. Select the desired TV Only monitor from the list by placing a checkmark in the box for the 

desired monitor. 
4. Select the "Off" button. 
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Configuring TV Only Monitors 
1. Select the "Service" menu. 
2. Select the "TV Control" menu item. 
3. Select the "Settings" button. 
4. Enter the Name of the TV Only Monitor in the "Name" field. 
5. Enter the number of the lane server where the TV Only monitor is connected in the "Lane Server" 

field. 
6. Enter the lane number of the speaker where the TV Only audio should be played. 
7. Select the "Close" button. 

 
DETAILS 

 
 
Overhead Monitors Section 
The "Lanes" field is used to enter the lane or lane range to be controlled by one of the following button 
actions: 
! Scoring - This button causes the overhead monitors to display scoresheet or advertising displays. 
! Video - This button causes the overhead monitors to display the TV video signal.  The video 

signal is provided to the Vector system at the Audio/Video (A/V) box.  Brunswick does not 
provide the video input. 

! Off - This button turns off the overhead monitors.  Typically it is used to turn off the monitors 
when the business is closed. 

 
TV Only Monitors Section 
This section is used to control monitors that are only used to display video.  The list of monitors is created 
by selecting the "Settings" button.  The "On" and "Off" buttons are used to turn the TV Only monitors on 
and off, respectively. 
  
The "Settings" button causes the following menu to be displayed: 
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This menu is used to configure the TV Only monitors. For each TV Only monitor a separate line must 
exist in the table.  For each line in this table the following fields must be filled in: 
! Name - This field is used to enter the name of the TV Only monitor that will be displayed on the 

TV Only monitor control page.  This is a text field that allows letters and numbers to be entered.  
The name of the TV Only monitor typically is something descriptive about the monitor's location. 

! Lane Server - This field is used to control which scoring computer the TV Only monitor is 
connected to.  This should be a number that corresponds to the scoring computer's name.  For 
example, if the TV Only monitor is connected to the first scoring computer called "SLAVE1" the 
number one is entered in this field. 

! Lane to Play the Audio - This field controls which lanes should receive the audio signal when the 
TV Only monitor is turned on.  For example, if the TV Only monitor is located between lanes two 
and three, where should the audio be heard when the TV Only monitor is turned on.  It is possible 
to make multiple lines in this table for the same monitor to allow different configurations of the 
audio. 
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Lane Settings (CtrlLane Settings (CtrlLane Settings (CtrlLane Settings (Ctrl----I)I)I)I)    
OVERVIEW 
This function is used to control some of the functions and appearance of the automatic scorer.  The scorer 
settings are not defaults, but the current setting in use on each lane.  The system will use the existing 
setting for all lane transactions until it is changed. 
  
PROCEDURES 
Controlling Lane Settings 

1. Select the "Settings" menu. 
2. Select the "Lane Settings" menu item. 
3. Select the desired lane tab, if there are more than 16 lanes. 
4. Make desired changes. 
5. Select the "OK" button. 

 
DETAILS 

 
  
The "Scoring/TV" option is used to control whether the overhead monitors will display scoring 
information or the video signal provided to Vector at the Audio/Video (A/V) Box.  When this option is 
selected the overhead will display the scoresheet and when this option is not selected video will be 
displayed. 
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The "Sound" option is used to control whether or not the sounds will be played with the exciter graphics.  
When this option is selected sounds will be heard from the scorer and when this option is not selected no 
sounds will be played with the exciter graphics. 
  
The "Picture" option is used to control whether or not the still frame exciter graphics will be displayed.  In 
order to randomize the appearance of the graphics a variety of graphics are used, including some graphics 
that are not animated.  When this option is selected still frame exciter graphics may be displayed during 
bowling and when this option is not selected still frame graphics will not be displayed. 
  
The "Anim" option is used to control whether or not the animated exciter graphics will be displayed.  In 
order to randomize the appearance of the graphics a variety of graphics are used, including some graphics 
that are animated.  When this option is selected animated exciter graphics will be displayed during 
bowling and when this option is not selected animated exciter graphics will not be displayed. 
  
The "Ball Velocity" option is used to control whether or not the ball speed will be displayed on the 
scoresheet.  If this option is selected the ball speed will be displayed on the scoresheet and when this 
option is not selected the ball speed will not be displayed on the scoresheet. 
  
The "Grid Type" drop down menu is used to select which scoresheet grid is in use.  The following grid 
types are available: 
! 10 Frame Display - This option will display all ten frames on the scoresheet. 
! 5 Frame Display - This option will display five frames on the scoresheet.  The five frame display 

will display the current frame and the previous four frames. 
! 5 x 2 Display - This option is used for doubles and singles tournament bowling.  A single bowler 

is entered on the odd and even lane, and the display will show the frames one through five on the 
odd lane and frames six through ten on the even lane.  This option is only available with the 
"Transparent" scoresheet. 

 
The "Scoresheet" drop down menu is used to select which scoresheet style is in use.  The following 
scoresheet styles are available: 
! Basic - The "Basic" scoresheet style uses a plain background and a completed scoresheet. 
! Flags - The "Flags" scoresheet is a transparent scoresheet that uses 500 x 280 bitmap images for 

the background.  As the game progresses more frames are added to the display and less of the 
background is visible. 

! PCB - The "PCB" scoresheet style uses a background that appears like a printed circuit board.   
As the game progresses more frames are added to the display and less of the background is 
visible. 

! Transparent - The "Transparent" scoresheet style is a completed scoresheet that is transparent for 
all of the bowlers that are not up to bowl.  The background is a 500 x 280 bitmap image. 

 
The "Background" drop down menu is used to select which background color or background image is 
used with the scoresheet.  For the "Basic" and "PCB" scoresheet styles have four color selections (Blue, 
Green, Purple and Orange).  The "Flags" scoresheet includes the flags from 96 different countries.  The 
"Transparent" scoresheet includes 17 backgrounds and additional graphics such as company logos, 
customer's pictures, birthday party backgrounds and so on can be used. 
  
The "Multimedia" drop down menu is used to select which set of exciter graphics is being used.  Exciter 
graphics are divided into groups based upon bowler demographics. 
  
The "Autoprint Mode" drop down menu is used to select which mode of automatic scoresheet printing is 
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being used.  Regardless of this setting scoresheets can be printed on demand for up to seven days.  The 
following printing modes are available: 
! Game - This option automatically prints scoresheets at the end of each game.  This option 

generates one printout per game. 
! End - This option automatically prints scoresheets at the end of each series or match.  This option 

generates one printout per series or match. 
! None - This option does not automatically print scoresheets. 
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Member Register (F6)Member Register (F6)Member Register (F6)Member Register (F6)    
OVERVIEW 
This function is used to track members in a database.  This database has three major functions.  First, the 
membership database is used to track bowler information such as name, address and telephone number.  
Second, the membership database is used to track customer spending via the Frequent Bowler Program.  
Third, the membership database is used to track bowling statistics such as the bowler's high game and 
average. 
  
PROCEDURES 
Adding A Bowler To The Membership Database 

1. Select the "Register" menu. 
2. Select the "Member Register" menu item. 
3. Select the "Add Member" button. 
4. Select the "Member Number" field and enter the member's number. 
5. Select the "Member Charge Paid Until" field and enter the date that the membership is to expire. 
6. Select the "Forename/First" field and enter the first name of the member. 
7. Select the "Surname/Last" field and enter the last name of the member. 
8. Select the "Street Address" field and enter the address of the member, if desired. 
9. Select the "City/ZIP" field and enter the City, State and Postal Code of the member, if desired. 
10. Select the "Address 3" field and enter additional address information, if necessary. 
11. Select the "Address 4" field and enter additional address information, if necessary. 
12. Select the "Telephone" field and enter the telephone number of the member, if desired. 
13. Select the "Average" field and enter the bowler's average, if desired. 
14. Select the "Club" field and enter the club that this bowler is a member of, if desired. 
15. Select the "Locker" field and enter the member's locker number, if desired. 
16. Select the "Locker Paid Until" field and enter the member's locker expiration date, if desired. 
17. Select the "Gender" drop down menu and select the member's gender. 
18. Select the "Birth Date" field and enter the member's birthday, if desired. 
19. Select the "Custom 1" field and enter any custom information to be tracked, if desired. 
20. Select the "Custom 2" field and enter any custom information to be tracked, if desired. 
21. Select the "OK" button. 

 
Changing Membership Information 

1. Select the "Register" menu. 
2. Select the "Member Register" menu item. 
3. Double click grey box to the left of the member to be changed. 
4. Make desired changes. 
5. Select the "OK" button. 
or 
1. Select the "Register" menu. 
2. Select the "Member Register" menu item. 
3. Double click in the field to be changed for the desired bowler. 
4. Make desired changes. 

 
Note:  Changes are automatically saved. 
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Deleting A Bowler From The Membership Database 
1. Select the "Register" menu. 
2. Select the "Member Register" menu item. 
3. Select the "Remove Member" button. 
4. Select the "Member Number" field and enter the member's number. 
5. Select the "OK" button. 
6. Select the "Yes" button to acknowledge the warning and delete the member, or select the "No" 

button to keep the member in the database. 
 
Searching The Membership Database 

1. Select the "Register" menu. 
2. Select the "Member Register" menu item. 
3. Select the "Search" button. 
4. Select the "Search For" field and enter the member's name or membership number. 
5. Select the "Search" button. 
6. Select the desired member from the search results window. 

 
Exporting The Membership Database 

1. Select the "Register" menu. 
2. Select the "Member Register" menu item. 
3. Select the "Export" button. 
4. Select the "File Name:" field and enter the name of the output file. 
5. Select the "Save" button. 

 
DETAILS 

 
  
The "Membership Number" field is used to enter a unique number for this member.  The number can be 
up to ten digits, and will automatically be padded with leading zeros.  For example, if the number 312 is 
entered, the system will save the number as 0000000312.  The membership numbers do not need to be 
consecutive and can be entered in logical groupings, such as 0-1000 for juniors, 2000-5000 for adults and 
so on.  If pre-numbered bar code cards are being used, the membership number must be the number on 
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the bar code card for each member. 
  
The "Member Charge Paid Until" field is used to enter the date when this member's membership will 
expire.  The system does not check this date or prevent members from using the system once they have 
expired, however, the system will print out expired members on the "Expired Members" report. 
  
The Forname/First and Surname/Last fields are used to enter the member's first and last names 
respectively. 
  
The "Street Address" field is used to enter the member's mailing address. 
  
The "City/ZIP" field is used to enter the member's city, state/region and ZIP/Postal Code. 
  
The "Address 3 and Address 4" fields are used to enter additional address information, such as an 
apartment number or country code.  It would also be possible to enter State and ZIP code information in 
these fields to allow greater flexibility in sorting. 
  
The "Telephone" number is used to enter the member's telephone number.  There is no formatting in this 
field, so that the telephone number can be entered as necessary to meet the local telephone numbering 
scheme. 
  
The "Average" field is used to enter an average for this member.  This field is not automatically updated 
from any program and is essentially used to enter a rating for this member.  Furthermore, this field is not 
used by the system for league or tournament bowling, nor does it update any external programs. 
  
The "Club" field is used to include this member in a group.  Different groups can be created for sorting 
purposes or for quickly selecting certain bowlers for an event.  The clubs are automatically created by 
typing a new club name in the "Club" field. 
  
The "Locker Number" field is used to track this member's locker number.  If this member has no locker, 
the value of zero should be left in this field. 
  
The "Locker Paid Until" field is used to enter the date that the locker fee expires.  The system does not 
check this date, or issue any notices regarding past due locker fees.  However, all the system will print out 
expired locker holders on the "Expired Lockers" report. 
  
The "Gender" drop down menu is used to select the gender for this member.  The "Members By Gender" 
report is based on the values in this field. 
  
The "Birth Date" field is used to enter the date of birth for this member.  The "Members By Birth Month" 
report is based on the values in this field. 
  
The "Custom 1" and "Custom 2" fields are used to enter other data that the bowling center may wish to 
track for each member in the database. 
  
Export Button 
On the "Membership Database" display is a button to export the database.  The database export format is 
"CSV" or Character Separated Value.  When the database is exported, a tab character is used to separate 
each field, and the data is stored in ASCII or text format.  The exported data could then be imported into 
another program, such as Microsoft Excel. 
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Statistics (F5)Statistics (F5)Statistics (F5)Statistics (F5)    
OVERVIEW 
This function is used to print out various statistics.  The following statistical reports are available: 
! Bowler Score Statistics - This report displays statistics for bowlers that used their membership 

identification number to download their name to the automatic scorer.  This report includes the 
following information:  High Game, Low Game, Average, Number of Games Bowled, Number of 
Strikes, Spares, Splits and Open Frames per game. 

! GS Error Log - This report displays error codes from GS series pinsetters.  This report is very 
useful for tracking persistent or intermittent problems. 

! Lane Usage Log - This report displays a graph of lane utilization for the selected date or date 
range. 

! Scoresheet Lane Control - This report displays detailed lane by lane usage information including 
number of frames bowled, time used and payment type. 

 
PROCEDURES 
Viewing And Printing A Bowler Score Statistics Report 

1. Select the "Register" menu. 
2. Select the "Statistics" menu item. 
3. Select the "BowlerScoreStat" report and select the "OK" button. 
4. Select the "From" date field and enter the desired start date of the report. 
5. Select the "To" date field and enter the desired ending date of the report. 
6. Select the "OK" button. 
7. To print the displayed report: 

1. Select the "File" menu. 
2. Select the "Print" menu item. 
3. Select the "OK" button. 

 
Viewing And Printing A GS Pinsetter Error Report 

1. Select the "Register" menu. 
2. Select the "Statistics" menu item. 
3. Select the "ErrorLog" report and select the "OK" button. 
4. Select the "From" date field and enter the desired start date of the report. 
5. Select the "To" date field and enter the desired ending date of the report. 
6. Select the "OK" button. 
7. To print the displayed report: 

1. Select the "File" menu. 
2. Select the "Print" menu item. 
3. Select the "OK" button. 

 
Viewing And Printing A Lane Usage Log Report 

1. Select the "Register" menu. 
2. Select the "Statistics" menu item. 
3. Select the "LaneUsageLog" report and select the "OK" button. 
4. Select the "From" date field and enter the desired start date of the report. 
5. Select the "To" date field and enter the desired ending date of the report. 
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6. Select the "OK" button. 
7. To print the displayed report: 

1. Select the "File" menu. 
2. Select the "Print" menu item. 
3. Select the "OK" button. 

 
Viewing And Printing A Scoresheet Lane Control Report 

1. Select the "Register" menu. 
2. Select the "Statistics" menu item. 
3. Select the "Scoresheet Lane Control" report and select the "OK" button. 
4. Select the "From" date field and enter the desired start date of the report. 
5. Select the "To" date field and enter the desired ending date of the report. 
6. Select the "OK" button. 
7. To print the displayed report: 

1. Select the "File" menu. 
2. Select the "Print" menu item. 
3. Select the "OK" button. 
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Open Play (F2)Open Play (F2)Open Play (F2)Open Play (F2)    
OVERVIEW 
This function is used to issue lanes in open play and cross lane open play.  Lanes may be issued in time or 
game bowling and payments may be made before or after bowling.  In addition to issuing lanes, various 
lane functions and options can be turned on or off when issuing the lane. 
  
PROCEDURES 

1. Select the "Rental" menu and then select the "Open Play" menu item. 
or 
1. Select the "Open Play" button on the Lane Status Display page. 
or 
1. Select the "F2" button on the keyboard. 
2. Select the "Lane" field and enter the desired lane, lanes or lane range.  Lanes may be entered in 

the "Lane" field in the following formats: 1; 1-2; 1-40; 1-8, 10; 1, 3, 5; and 1 3 5. 
3. Select either the "Single Lane" or "Cross Lane" option.  Note:  Single Lane (open play) is 

selected by default. 
4. If desired, select either the "Time" or "Frames" practice option and then select the "Practice" field 

and enter the number of minutes for the lane or lane range or the number of frames of practice per 
bowler, depending on which practice option was selected.  If no practice is desired, set the value 
in the "Practice" field to zero.  Note:  The default values in these fields are set on the Settings 
menu. 

5. If desired, select the "Printer" drop down menu to select an automatic scoresheet printing option.  
The following options are available: 
! Game - When this option is selected scoresheets will be automatically printed at the end of 

each game.  This mode creates one printed page for each game bowled by a team or group of 
bowlers. 

! End - When this option is selected scoresheets will be automatically printed at the end of each 
series or match.  This mode creates one printed page for each match by bowler, unless the 
"Print Bowlers On Separate Pages" option is selected, which will cause the system to print a 
separate page for each bowler. 

! None - When this option is selected scoresheets will not be automatically printed, but 
scoresheets will remain available for manual selection and printing up to seven days. 

6. If prepaid bowling is desired, enable the "Automatic Lanestop" option in the "Lane Shutdown 
Selection. 
! Select either the "Time" or "Game(s)/Player" option for time bowling or game bowling 

respectively. 
! Select either the "Minutes" or "Games" field and enter the desired amount of time or number 

of games. 
7. In the "Names" section, select the "Lane" drop down menu to select the desired lane for name 

entry, if necessary.  If the transaction only involves a single lane, this step is not required. 
8. Select the "Number of Players" field and enter the number of names to be entered on the lane. 
9. Select the "Player Names" fields and enter the bowler's names.  If a bowler presents a 

membership card, the number can be entered and the name will be automatically loaded from the 
database.  Alternatively the bar code card can be scanned by the optional bar code reader, and the 
bowler name will be automatically loaded from the database.  If the membership card is not 
available, the database can be searched by pressing the plus button (+) on the keyboard.  Linking 
a lane transaction with a bowler name is required for bowler statistics to be generated. 
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10. Select the "Mode" drop down menus and select the desired mode of bowling, if desired.  Options 
include regular ten pin bowling, No-tap bowling, 369 bowling and combinations of these formats. 

11. Select the "Price Rate" drop down menus for each bowler and select the desired bowling article or 
price.  This option may not be available if it was turned off on the "Front Desk" tab of the "Setup" 
menu. 

12. If the center is equipped with automated bumpers and the ability to issue bumpers has been 
enabled on the "Front Desk" tab of the "Setup" menu, enable the bumpers for the desired bowlers 
by placing a checkmark in the "Bumper" check box. 

13. Select the "Birthday" checkbox to enable the special birthday exciter graphics, or leave the 
"Birthday" checkbox blank if the birthday exciters are not to be used.  NOTE:  The birthday 
graphics require the "Kids" multimedia set to be selected on the "Lane Settings" menu. 

14. Select the "Start" button to issue the lane.  If an autostop option was selected, the payment page 
may automatically be displayed at this point, if the "Charge Immediately For Payment" option 
was selected on the Settings page.  If the payment page is not displayed automatically, the 
operator must remember to manually select the payment page and make the appropriate payment.  
Alternatively, the "Reserve" button can be selected and this would create a lane reservation using 
the information entered above.  See also "Reservations" for more information. 

 
DETAILS 

 
  
The "Lane" field is used to enter the lane numbers to be issued.  Lane numbers may be entered in a 
variety of ways.  For example:: 1; 1-2; 1-40; 1-8, 10; 1, 3, 5; and 1 3 5. 
  
The "Single Lane" and "Cross Lane" options control whether the lanes will be issued in a single lane 
(open play) mode or as a pair of lanes in cross lane mode.  When lanes are issued in single lane mode, all 
the frames of the game will be bowled on the same lane.  When lanes are issued in cross lane mode, the 
frames will alternate between the odd and even lanes of the pair.  If names are to be entered only on one 
lane of the lane pair, there are two options.  First, enter only one lane of the pair in the "Lane" field and 
enter the names on this lane.  Second, enter the lane pair in the "Lane" field and select one of the lanes 
and enter zero in the "Number of Players" for that lane. 
  
The "Time" and "Frames" practice options control the type of practice to be issued with the selected 
lanes.  If "Time" is selected the number of minutes entered into the "Practice" field will be used for each 
lane of the range.  If "Frames" is selected the number of frames entered into the "Practice" field will be 
issued to each player at the time the lane is issued.  Practice will be displayed on the automatic scorer.  
Practice frames and time is always accounted for.  There are many ways to charge for practice frames or 
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time.  Frame practice can be charged at a rate of 10% of the regular bowling rate or a special frame 
practice article can be created with its own price.  Time practice can be charged at a rate of 1/60th of the 
price per hour or a special time practice article can be created with its own price.  If no practice is desired, 
set the "Practice" field to zero. 
  
The "Automatic Lanestop" option controls whether or not the lanes will turn off automatically.  If "Time" 
is selected the lanes will turn off automatically at the end of the number of minutes entered.  If "Games" 
is selected the lanes will turn off at the end of the number of games entered.  Typically Automatic 
Lanestop is used for prepaid bowling activities, and the payment page will automatically be displayed 
when a lane or lane range is issued.  This allows for the payment to be made prior to bowling.  However, 
the system is capable of turning lanes off automatically at the end of a set time or number of games, but 
taking payment after the bowling activity.  This can be useful for party activity.  The negative aspect of 
this type of payment is that the employee must remember to take the payment. 
  
The "Lane" drop down menu in the "Names" section is used to control which lane's bowler names are 
being displayed in the "Name's" section.  This allows names to be entered for each lane of a multi-lane 
transaction.  If a single lane is being issued, the drop down menu will only list the single lane. 
  
The "Number of Players" field is used to control the number of names that is initially being issued to the 
lane.  This is critical for the calculation of the number of practice games, as well as the total number of 
games being initially issued to a lane when "Automatic Lanestop" is selected. 
  
The "Birthday" option controls whether or not the special birthday exciter graphics will be used for this 
lane transaction.  If the box is checked, the special birthday exciter graphics will be used.  If the box is 
unchecked the standard graphics will be used.   
 
Note: The birthday graphics require the "Kids" multimedia set to be selected on the "Lane Settings" page. 
  
The "Names" fields are used to enter the bowlers name for this lane transaction.  The default names of 
"Player1", "Player2" and so on can be used, or the bowler's real name can be entered manually.  
Additionally, if the bowler is a member of the membership database, the plus key (+) on the keyboard can 
be used to open the search tool of the database so that a name can be looked up.  Also, the bowler's 
membership number can be typed into the name field and the system will automatically display the 
bowler's name.  Finally the bar code card could be scanned by the optional bar code scanner.   
 
Note: In order for the system to track bowler statistics, the name of the bowler must be entered from the 
database, by number or by scanning the card. 
  
The "Mode" drop down menus are used to select the type of bowling for each bowler.  The following 
bowling types are available: 
! Normal:  When this mode is selected regulation ten pin bowling will be played. 
! Notap 9:  When this mode is selected, the system will score nine or ten pins bowled over as a 

strike. 
! Notap 8:  When this mode is selected, the system will score eight, nine or ten pins bowled over as 

a strike. 
! Notap 7:  When this mode is selected, the system will score seven, eight, nine or ten pins bowled 

over as a strike. 
! Notap 6:  When this mode is selected, the system will score six, seven, eight, nine or ten pins 

bowled over as a strike. 
! 369:  When this mode is selected the bowler will be awarded with an automatic strike in the third, 

sixth and ninth frames of each game, without bowling those frames. 
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! 369 + NT9:  When this mode is selected the system will combined Notap 9 with 369. 
! 369 + NT8:  When this mode is selected the system will combined Notap 8 with 369. 
! 369 + NT7:  When this mode is selected the system will combined Notap 7 with 369. 
! 369 + NT6:  When this mode is selected the system will combined Notap 6 with 369. 

 
The "Price Rate" drop down menus are used to select the bowling rate for each bowler.  The system will 
automatically select the proper rate for the day and time of bowling, but the operator may select another 
rate, if permitted by system settings.  The operator can also change the rate on the payment page. 
  
The "Bumper" option is used to control whether or not each bowler will receive bumpers if the center is 
equipped with Brunswick automated bumpers. 
  
The "Reserve" button is used to make a reservation based upon the open play information entered.  See 
also "Reservations" 
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League Play (F7)League Play (F7)League Play (F7)League Play (F7)    
OVERVIEW 
This function is used to issue and control league lanes.  The league function issues those lanes that are 
stand alone, or not using a league statistics program such as CDE Bowling League Secretary, as well as 
those that do use a league statistical program. 
  
PROCEDURES 
Issuing League Lanes 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "American League" menu item and select the "OK" button. 
3. Select the "=== Stand Alone Mode ===" menu item. 
4. Select the "Lanes" field and enter the desired lane range. 
5. Select the "Players/Lane" field and enter the number of players per team. 
6. Select the "Games" field and enter the number of games in the series. 
7. Select either the "Single Lane" or "Cross Lane" option.  "Cross Lane" is selected by default. 
8. Using the "Method" drop down menu, select the type of bowling.  "Normal" is selected by 

default. 
9. Select either the "Minutes" or "Frames" practice option, followed by entering the number of 

minutes or frames of practice in the "Practice" field.  If no practice is desired, enter zero in the 
"Practice" field. 

10. If name entry is desired, select the "Lane" field on the bottom left of the menu to select the odd 
lane of first lane pair of the lane range. 

11. Select the team name field and enter the team's name, if desired. 
12. Select the "Forfeit" option if there is no team to be entered on this lane. 
13. Select the "Name" fields and enter the bowler's names, if desired. 
14. Select the bowler type drop down menus and select the bowler type for each bowler, if desired. 
15. Select the "Ave" fields and enter the bowler's average, if desired. 
16. Select the "HCP" fields and enter the bowler's handicap value, if desired. 
17. Select the "Abs" fields and enter the bowler's absentee score, if desired. 
18. Repeat steps ten through seventeen for the even lane of the pair. 
19. Select the "Lane" field on the bottom left of the menu to select the odd lane of next lane pair of 

the lane range. 
20. Repeat step nineteen until the information has been entered for all of the teams. 
21. Select the "Config" button and select the scoresheet type and backgrounds for each game of the 

series, if desired.  Note: Config settings affect ALL leagues, not just the league being assigned. 
22. Select the "Use Scorer Only Mode" option to issue the league lanes without turning on the 

pinsetters, or leave the option blank to issue the league lanes with the pinsetters active. 
23. Select the "Start" button to start the entire league, or use the "Start Pair" button to start only the 

lane pair displayed when the button is selected. 
 
Issuing CDE League Lanes 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
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or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "American League" game menu item and select the "OK" button. 
3. Select the desired day of the week.  Today is automatically selected by default. 
4. Select the desired league from the list of leagues.  If there are no leagues listed, select the browse 

(...) button and to verify Vector is looking in the same directory where the league program is 
exporting the league data. 

5. Select either the "Minutes" or "Frames" practice option, followed by entering the number of 
minutes or frames of practice in the "Practice" field.  If no practice is desired, enter zero in the 
"Practice" field. 

6. Select the "Forfeit" option if there is no team to be entered on this lane. 
7. Select the bowler type drop down menus and select the bowler type for each bowler, if desired. 
8. Repeat steps six through seven for the even lane of the pair. 
9. Select the "Lane" field on the bottom left of the menu to select the odd lane of next lane pair of 

the lane range. 
10. Repeat step nine until the information has been entered for all of the teams. 
11. Select the "Config" button and select the scoresheet type and backgrounds for each game of the 

series, if desired. 
12. Select the "Use Scorer Only Mode" option to issue the league lanes without turning on the 

pinsetters, or leave the option blank to issue the league lanes with the pinsetters active. 
13. Select the "Start" button to start the entire league, or use the "Start Pair" button to start only the 

lane pair displayed when the button is selected. 
 
End Scorer Only Mode 

1. Select the "Change" menu. 
2. Select the "End Scorer Only..." menu item. 
3. Enter the desired lanes, or select the lanes from the lane list. 
4. Select the "OK" button. 

 
DETAILS 
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The "Day" tabs are used to list the leagues for a specific day of the week.  The current day is selected by 
default.  The league list will always display "=== Stand Alone Mode ===" in addition to the interfaced 
leagues that have been successfully exported (the export directory is shown to the right, next to the "..." 
button.  This list is used to select a league or stand alone mode for subsequent operations. 
  
The "Lanes" field is used to select which lanes are to be used by a stand alone league.  This field is not 
available when an interfaced league is selected from the list, since the interfaced league's rules control the 
lane range to be used. 
  
The "Teams" field is automatically computed based upon the number of lanes selected. 
  
The "Players/Lane" field is used to select how many bowlers are on each team.  This number represents 
the actual playing strength of the team, and does not include team or floating substitutes.  This field is not 
available when an interfaced league is selected from the list, since the interfaced league's rules control the 
number of players and roster size of each team. 
  
The "Games" field is used to control the number of games to be bowled in the series or match.  This field 
is not available when an interfaced league is selected from the list, since the interfaced league's rules 
control the number of games in the series. 
  
The "Single Lane" or "Cross Lane" style options are used to control whether the pairs of lanes will be in 
single lane or cross lane bowling mode.  When lanes are in single lane mode, all frames are bowled on the 
lane where the bowler's name is entered.  When the lanes are in cross lane mode the frames will be 
bowled alternating between the odd and even lanes of the pair. 
  
The "Method" drop down menu is used to control the type of bowling for the league.  The following 
bowling types are available: 
! Normal:  When this mode is selected regulation ten pin bowling will be played. 
! Notap 9:  When this mode is selected, the system will score nine or ten pins bowled over as a 

strike. 
! Notap 8:  When this mode is selected, the system will score eight, nine or ten pins bowled over as 

a strike. 
! Notap 7:  When this mode is selected, the system will score seven, eight, nine or ten pins bowled 

over as a strike. 
! Notap 6:  When this mode is selected, the system will score six, seven, eight, nine or ten pins 

bowled over as a strike. 
! 369:  When this mode is selected the bowler will be awarded with an automatic strike in the third, 

sixth and ninth frames of each game, without bowling those frames. 
! 369 + NT9:  When this mode is selected the system will combined Notap 9 with 369. 
! 369 + NT8:  When this mode is selected the system will combined Notap 8 with 369. 
! 369 + NT7:  When this mode is selected the system will combined Notap 7 with 369. 
! 369 + NT6:  When this mode is selected the system will combined Notap 6 with 369. 

 
The practice "Time" and "Frames" option is used to control the type of practice for this league.  When the 
"Time" option is selected the league will be allotted the number minutes entered into the "Practice" field.  
Each lane will display the total time and the counter will decrement until zero is reached.  At that time a 
graphic will be displayed to end practice, and an automatic announcement will be made that practice is 
over and that the pinsetters should be cycled to the first ball.  When the "Frames" option is selected the 
league will be allotted the number of frames per bowler entered into the "Practice" field.  Each lane will 
sequence the bowler for practice.  When the number of frames issued is completed, a graphic will be 
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displayed to end practice, and an automatic announcement will be made that practice is over and that the 
pinsetters should be cycled to the first ball.  If no practice is desired, enter zero into the "Practice" field.   
 
Note:  To change the amount of practice after the lanes have been issued, select the "Change Practice" 
menu item on the "Change" menu. 
  
If a CDE league is highlighted on the league list, there will be a CDE Bowling League Secretary (BLS) 
icon displayed that will launch the CDE BLS program.  The "Delete" button is used to delete the selected 
CDE league from the selected directory.  The browse "..." button is used to select the directory where the 
interfaced leagues have been exported.  This must match the league directory where the CDE program has 
exported the league files.  Once a directory has been selected it will be displayed next to the browse 
button. 
  
The "Lane" field is used to select which pair of teams is being displayed at the bottom of the league 
menu.  Although an odd or even lane number can be entered, it is recommended that the odd lane number 
be entered for consistency.  Once a lane number has been entered the teams for that lane pair will be 
displayed. 
  
The team name field is used to enter the name of the team.  This field is not available when an interfaced 
league is selected from the list, since the team's name is downloaded from the interfaced league program. 
  
The "Forfeit" option is used to control whether or not names are downloaded to this lane of the pair.  
Typically it is used for leagues that are short teams.  Alternatively, a team of vacant bowlers can be used. 
  
The "Player Name" fields are used to enter the bowler's names.  The bowler's names will appear on the 
scorer exactly as they are entered.    This field is not available when an interfaced league is selected from 
the list, since the bowler's names are downloaded from the interfaced league program. 
  
The bowler type drop down menu is used to select the bowler type for each bowler.  The following 
bowler types are available: 
! Regular - This bowler type is used when a member of the team that is present to bowl. 
! Substitute - This bowler type is used when a regular member of a team is not available and a 

substitute will bowl in their place. 
! Absent - This bowler type is used when a regular member of a team is not available and a 

substitute bowler is not available or permitted.  The bowler's score will be the absentee score 
entered in or downloaded to the "Abs" field.  The absentee score is computed based upon league 
rule, but generally is the bowler's average minus a penalty. 

! Vacant - This bowler type is used when a team is incomplete and does not have a full roster of 
regular members.  The vacant bowler's score is determined by league rule and entered in or 
downloaded to the "Vac" field. 

! Pacer - This bowler type is used in addition to the "Absent" bowler type mentioned above.  When 
a team has an absent bowler, it will bowl at a different pace than the team with a full roster.  
Some leagues choose to add a pacer bowler to that team to keep the teams bowling at the same 
pace.  The pacer's scores are not used for calculating the wins and losses of the team, the absentee 
score is used instead. 

 
The "Ave" field is used to enter the bowler's actual average.    This field is not available when an 
interfaced league is selected from the list, since the bowler's average is downloaded from the interfaced 
league program. 
  
The "HCP" field is used to enter the bowler's individual handicap value.    This field is not available when 
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an interfaced league is selected from the list, since the bowler's individual handicap value is downloaded 
from the interfaced league program. 
  
The "Abs" field is used to enter the bowler's absentee score.    This field is not available when an 
interfaced league is selected from the list, since the bowler's absentee score is downloaded from the 
interfaced league program. 
  
The "Use Scorer Only Mode" option is used to control the manner that the league lanes will be issued.  
With this option selected, when the league is started the scores will turn on without pinsetters, displaying 
the team and bowler information on the scorer.  This is typically used when the league lanes can be issued 
well in advance of the time the league bowls so that name changes and substitutions can be made, without 
the bowlers being able to practice.  When it is time to begin the practice bowling, the "End Scorer Only 
Mode" procedure should be used.  When this option is not selected the lanes will be issued with pinsetters 
and if practice was enabled it will start at that time. 
  
The "Start" button starts all the lanes of the league. 
  
The "Start Pair" button starts just the pair of lanes that is visible on the league menu at the time the button 
is selected. 
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Tournament PlayTournament PlayTournament PlayTournament Play    
OVERVIEW 
This function is used to issue and control tournament lanes.  The tournament function issues those lanes 
that are stand alone, or not using a tournament statistics program such as CDE Tournamator 3/32.  The 
"League" function is used to issue CDE Tournamator 3/32 lanes. 
  
PROCEDURES 
Creating A Tournament 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "Tournaments" menu item and select the "OK" button. 
3. Select the "New" button. 
4. Select the "Tournament Name" field and enter the name of the tournament. 
5. Select the "First Lane Used" field and enter the first lane number of the range to be used. 
6. Select the "Last Lane Used" field and enter the lane number of the last lane in the range to be 

used.  Note: If the tournament uses lane rotations, enter the highest lane the bowlers will use.  
This is sometimes referred to as the "turn lane". 

7. Select the "Number of Games" field and enter the quantity of games to be bowled in each squad. 
8. If the bowlers will change lanes during bowling, select the "Number of Lanes to Move" field and 

enter the quantity of lanes that the bowlers will move to the right during bowling.  And, select the 
"Number of Games to Move After" field and enter how many games will be bowled before 
rotating. 

9. Select the type of bowling by choosing one of the following options: 
! Single Lane - When this option is selected all frames of the game will be bowled on the lane 

where the bowler's names are entered. 
! Cross Lane - When this option is selected frames will alternate between the odd and even 

lanes of the pair. And, each new game will start on the opposite lane from where the previous 
game was completed.  This means that all games will start on the lane where the bowler's 
name is entered.  This method is recommended when there is lane rotation. 

! Cross Lane with Shift - When this option is selected frames will alternate between the odd 
and even lanes of the pair. And, each new game will start on the lane where the previous 
game completed.  This means that every other game of the series will start on the opposite 
lane of the pair.  This method is recommended when there is no lane rotation. 

10. Select the team format by choosing one of the following options: 
! Single - When this option is selected teams of one are used. 
! Double - When this option is selected teams of two are used. 
! Triple - When this option is selected teams of three are used. 

11. Select the "Use HCP" option if handicaps will be added to the bowler's scores. 
12. Select the "Use Bonus" option if bonus pins will be added to the bowler's scores for bowling 

within the ranges defined in the bonus section.  If this option is chosen, select the "Number of 
Bonus Levels Used" field and enter the number of bonus levels that will be created in the bonus 
section and select the "Number of Categories Used" field and enter the number of categories 
(similar to divisions) that will be created in the bonus section.  Select the "Bonus/Group" fields 
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and enter the number of bonus points that will be awarded for bowling with the score range 
entered in the "Interval" fields.  Select the "Interval" fields for each category and enter the range 
of scores that will qualify for the bonus points. 

13. Select the "OK" button. 
 
Changing Tournament Rules 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "Tournaments" menu item and select the "OK" button. 
3. Select the desired tournament by highlighting it on the tournament list. 
4. Select the "Edit" button. 
5. Make desired changes. 
6. Select the "OK" button. 

 
Deleting A Tournament 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "Tournaments" menu item and select the "OK" button. 
3. Select the desired tournament by highlighting it on the tournament list. 
4. Select the "Delete" button. 
5. Select the "Yes" button to acknowledge the warning message and delete the tournament. 

 
Creating A Shift (Squad) 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "Tournaments" menu item and select the "OK" button. 
3. Select the desired tournament by highlighting it on the tournament list. 
4. Select the "New Shift" button. 
5. Select the "Number of Players in Shift" field and enter the total number of bowlers in this shift or 

squad of bowlers. 
6. Select the "Number of Players Per Lane" field and enter the number of bowlers on each lane 

followed by the "Apply" button. 
7. Select the "Lane" number field for the bowler in Position One (the line number at the left side of 

the display) and enter the bowler's lane number. 
8. If desired, select the "ID" field and enter the bowler's "Membership Database" identification 

number or scan the bowler's bar code. 
9. Select the "First Name" field and enter the bowler's first name if the bowler's name wasn't 

previously entered from the membership database. 
10. Select the "Last Name" field and enter the bowler's last name if the bowler's name wasn't 

previously entered from the membership database. 
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11. Select the "Team Name" field and enter the team's name, if desired. 
12. If "Bonus Levels" were selected when the tournament was defined, select the "Category drop 

down menu to select the "Bonus Level Category" for this bowler. 
13. If handicaps were selected when the tournament was defined, select  the "HCP/Game" field and 

enter the amount of handicap that this bowler is to receive for each game.  Note: Bowler's 
handicaps are not calculated by the system.  The handicap value entered in this field is the value 
added to the bowler's game scores. 

14. If desired, select the "AVE" field and enter the bowler's average. 
15. Repeat steps seven through fourteen for the remaining bowlers in this shift.  Note: If more than 

eight bowlers were selected for this shift, use the "<<Back" and "Next>>" buttons to view the 
other bowlers. 

16. When all bowlers for the shift have been entered, select the "OK" button. 
 
Changing A Shift (Squad) 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "Tournaments" menu item and select the "OK" button. 
3. Select the desired tournament by highlighting it on the tournament list. 
4. Select the "Edit Shift" button. 
5. Make desired changes. 
6. Select the "OK" button. 

 
Deleting A Shift (Squad) 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "Tournaments" menu item and select the "OK" button. 
3. Select the desired tournament by highlighting it on the tournament list. 
4. Select the "Delete Shift" button. 
5. Select the "Yes" button to acknowledge the warning message and delete the shift. 

 
Issuing Tournament Lanes 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "Tournaments" menu item and select the "OK" button. 
3. Select the desired tournament by highlighting it on the tournament list. 
4. Using the "Shift" drop down menu, select the desired shift. 
5. If desired, select the "Printer" drop down menu to select an automatic scoresheet printing option.  

The following options are available: 
! Game - When this option is selected scoresheets will be automatically printed at the end of 
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each game.  This mode creates one printed page for each game bowled by a team or group of 
bowlers. 

! End - When this option is selected scoresheets will be automatically printed at the end of each 
series or match.  This mode creates one printed page for each match by bowler, unless the 
"Print Bowlers On Separate Pages" option is selected, which will cause the system to print a 
separate page for each bowler. 

! None - When this option is selected scoresheets will not be automatically printed, but 
scoresheets will remain available for manual selection and printing up to seven days. 

6. Select either the "Minutes" or "Frames" practice option, followed by entering the number of 
minutes or frames of practice in the "Practice" field.  If no practice is desired, enter zero in the 
"Practice" field. 

7. Select the "Start Shift For Scoring" button. 
 
Viewing Tournament Results 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "Tournaments" menu item and select the "OK" button. 
3. Select the desired tournament by highlighting it on the tournament list. 
4. The current standings will be displayed from highest to lowest. 

 
Printing Tournament Results 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "Tournaments" menu item and select the "OK" button. 
3. Select the desired tournament by highlighting it on the tournament list. 
4. The current standings will be displayed from highest to lowest. 
5. Select the "Print" button. 
6. Select either the "Individual" or "Team" report type and select the "Print" button. 
7. If necessary, select the desired printer and printer options. 
8. Select the "Print" button. 

 
Exporting Tournament Results 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "Tournaments" menu item and select the "OK" button. 
3. Select the desired tournament by highlighting it on the tournament list. 
4. The current standings will be displayed from highest to lowest. 
5. Select the "Export" button. 
6. Select the desired export format followed by the "OK" button. 
7. Select the export file location and file name followed by the "Save" button. 
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DETAILS 

 
  
The "Tournament Name" field is used to identify this tournament on reports and on the tournament list. 
  
The "Number of Lanes to Move" field controls the number of lanes that bowlers will rotate after the 
number of games specified in the "Number of Games to Move After" field.  The only rotation option is 
for all bowlers to move to the right the specified number of lanes.  If no lane rotation is desired, enter zero 
in this field. 
  
The "Number of Games to Move After" field is used to control when lane rotation will occur.  The 
rotation will occur after the number of games entered into this field. 
  
The "First Lane Used" field is used to enter the first lane of the range of lanes to be used for this 
tournament. 
  
The "Last Lane Used" field is used to enter the last lane of the range of lanes to be used for this 
tournament. 
  
The "Number of Games" field is used to control the number of games bowled during this tournament.  
The maximum number of games allowed is nine. 
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The "Use HCP" option is used to control whether or not handicaps will be added to the bowler's game 
scores.  The system does not calculate a bowler's handicap.  It is manually entered on the "Shift" page.   
  
The "Use Bonus" option is used to control whether or not the bonus system will be used.  The bonus 
system gives a bowler additional pins for bowling a score within two values.  This system can be 
considered a handicap based upon what you actually bowl, instead of based upon an historic average.  
There can be up to ten levels or ranges of scores used to award bonus pins and the bonus pins can be 
different for up to five categories of bowlers. 
  
The "Number of Bonus Levels Used" field controls how many different levels or ranges of scores will be 
entered into the system. 
  
The "Number of Categories Used" field controls how many different categories of bowlers are in the 
tournament.  A category is similar to a division and is used to give different bonus pins to bowlers based 
upon skill or some other variable such as gender. 
  
The "Single", "Double" and "Triple" options are used to control how many bowlers are on a team in the 
tournament and will control the appearance of the teams on the overhead displays. 
  
The "Single Lane", "Cross Lane" and "Cross Lane With Shift" options are used to control the method of 
bowling during the tournament.   
  
When "Single Lane" is selected all frames of the game will be bowled on the lane where the bowler's 
names are entered.   
  
When "Cross  Lane" is selected frames will alternate between the odd and even lanes of the pair. And, 
each new game will start on the opposite lane from where the previous game was completed.  This means 
that all games will start on the lane where the bowler's name is entered.  This method is recommended 
when there is lane rotation. 
  
When "Cross Lane with Shift" is selected frames will alternate between the odd and even lanes of the 
pair. And, each new game will start on the lane where the previous game completed.  This means that 
every other game of the series will start on the opposite lane of the pair.  This method is recommended 
when there is no lane rotation. 
  
The "Bonus/Group" fields are used to enter the amount of bonus pins given for bowling a score within the 
range entered as the interval for each category. 
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The "Shift" drop down menu is used to select which shift is being added or changed.  The "Number of 
Players in Shift" field is used to enter the total number of bowlers in this shift.  The "Active Game" field 
can be used to start the match on a game other than the first game.  For example, if there is a power 
failure and the lanes need to be started for the second game of the match, enter two into this field.  The 
"Number of Players Per Lane" field is used to enter the number of bowler names that will be sent to each 
lane of the range of lanes selected. 
  
The "Lane" fields are used to assign a bowler to the desired lane.  The "ID Code" fields are used to enter 
the "Membership Database" number for a bowler.  The membership number can be typed in, scanned, or 
if the button with the man icon is used the bowlers can be This allows names to be entered without typing 
the names. 
  
The "First Name" and "Last Name" fields are used to enter the bowler's names if they were not 
downloaded from the database.  The "Team Name" field is used to enter the name of the team.  The 
"Category" drop down menu is used to select the category for this bowler.  The category controls which 
set of bonus pins will be awarded to this bowler based upon the settings. 
  
The "HCP/Game" field is used to enter the amount of handicap give to the bowler for each game.  The 
number entered in this field will be added to each game.  This is not a calculated field and must be 
manually entered.  The "AVE" field is used to enter the bowler's entering average. 
  
The "G1" through "G9" fields are used to display and/or change the bowled score for games one through 
nine of the shift. 
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The "New" button is used to create a new tournament definition.  The "Edit" button is used to change the 
rules of an existing tournament.  The "Delete" button is used to delete an existing tournament.  The 
tournament list displays all existing tournaments and is used to select which tournament will be changed 
or deleted as well as selected for further operations, such as issuing lanes for a specific shift. 
  
The "New Shift" button is used to create a new shift in an existing tournament.  This button is not 
available until the rules for a tournament have been created.  The "Edit Shift" button is used to change the 
rules for an existing shift.  The "Delete Shift" button is used to delete an existing shift.  The "Shift" drop 
down menu is used to select which shift is being viewed, changed or deleted, as well as selected for 
subsequent operations such as issuing lanes.  The "Printer" drop down menu is used to select whether or 
not scoresheets will be printed automatically.  If scoresheets are printed automatically, this menu controls 
whether the scoresheets will be printed after each game or after the series.  The "Time" and "Frames" 
practice options are used to control the type of practice used for the shift.  The "Practice" field is used to 
enter the amount of minutes of "Time" practice or the number of frames of "Frame" practice.  The "Start 
Shift for Scoring" button is used to start practice bowling for the selected shift. 
  
The "Export" button is used to create a text file of the bowler information and scores displayed on the 
bowler list.  This information is exported in ASCII text with each data field being separated by a tab 
character.  This allows tournament information to be easily imported to another program such as 
Microsoft Excel. 
  
The "Print" button is used to print the bowler information and scores displayed on the bowler list. 
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Red Head PinRed Head PinRed Head PinRed Head Pin    
OVERVIEW 
This function is used to issue lanes in open play and cross lane open play with the Red Head Pin game 
enabled.  The Red Head Pin game is regular ten pin bowling with a simulated red pin in the pinsetter.  
During the Red Head Pin game, the pop-up pin triangle will be used to display the position of the Red 
Head Pin for that frame.  When the Red Head Pin is in the head pin position, a center defined message is 
displayed to inform the bowler that they have a chance at a Red Head Pin win.  The bowler must get a 
strike to win.  On the scoresheet, Red Head Pin chances will be tracked with a red background in the first 
ball of the frame where the Red Head Pin chance occurred.  If the bowler gets a strike and wins the Red 
Head Pin chance, a second center defined message will be displayed to announce that a prize has been 
won.  The scoresheet printouts will show the red head pin chances and wins.  The "Payment" page will 
also track the Red Head Pin wins and will allow coupons to be issued for each win.  Lanes may be issued 
in time or game bowling and payments may be made before or after bowling.  In addition to issuing lanes, 
various lane functions and options can be turned on or off when issuing the lane.  All of the Red Head Pin 
options are controlled in the Red Head Pin configuration. 
  
PROCEDURES 

1. Select the "Rental" menu and then select the "Match Play" menu item. 
or 
1. Select the "League" button on the Lane Status Display page. 
or 
1. Select the "F7" button on the keyboard. 
2. Select the "Red Head Pin" game menu item and select the "OK" button. 
3. Select the "Lane" field and enter the desired lane, lanes or lane range.  Lanes may be entered in 

the "Lane" field in the following formats: 1; 1-2; 1-40; 1-8, 10; 1, 3, 5; and 1 3 5. 
4. Select either the "Single Lane" or "Cross Lane" option.  Note:  Single Lane (open play) is 

selected by default. 
5. If desired, select either the "Time" or "Frames" practice option and then select the "Practice" field 

and enter the number of minutes for the lane or lane range or the number of frames of practice per 
bowler, depending on which practice option was selected.  If no practice is desired, set the value 
in the "Practice" field to zero. 

6. If desired, select the "Printer" drop down menu to select an automatic scoresheet printing option.  
The following options are available: 
! Game - When this option is selected scoresheets will be automatically printed at the end of 

each game.  This mode creates one printed page for each game bowled by a team or group of 
bowlers. 

! End - When this option is selected scoresheets will be automatically printed at the end of each 
series or match.  This mode creates one printed page for each match by bowler, unless the 
"Print Bowlers On Separate Pages" option is selected, which will cause the system to print a 
separate page for each bowler. 

! None - When this option is selected scoresheets will not be automatically printed, but 
scoresheets will remain available for manual selection and printing up to seven days. 

7. If prepaid bowling is desired, enable the "Automatic Lanestop" option in the "Lane Shutdown 
Selection. 
! Select either the "Time" or "Game(s)/Player" option for time bowling or game bowling 

respectively. 
! Select either the "Minutes" or "Games" field and enter the desired amount of time or number 
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of games. 
8. In the "Names" section, select the "Lane" drop down menu to select the desired lane for name 

entry, if necessary.  If the transaction only involves a single lane, this step is not required. 
9. Select the "Number of Players" field and enter the number of names to be entered on the lane. 
10. Select the "Player Names" fields and enter the bowler's names.  If a bowler presents a 

membership card, the number can be entered and the name will be automatically loaded from the 
database.  Alternatively the bar code card can be scanned by the optional bar code reader, and the 
bowler name will be automatically loaded from the database.  If the membership card is not 
available, the database can be searched by pressing the plus button (+) on the keyboard.  Linking 
a lane transaction with a bowler name is required for bowler statistics to be generated. 

11. Select the "Mode" drop down menus and select the desired mode of bowling, if desired. 
12. Select the "Price Rate" drop down menus for each bowler and select the desired bowling article or 

price.  This option may not be available if it was turned off on the "Front Desk" tab of the "Setup" 
menu. 

13. If the center is equipped with automated bumpers and the ability to issue bumpers has been 
enabled on the "Front Desk" tab of the "Setup" menu, enable the bumpers for the desired bowlers 
by placing a checkmark in the "Bumper" check box. 

14. Select the "Birthday" checkbox to enable the special birthday exciter graphics, or leave the 
"Birthday" checkbox blank if the birthday exciters are not to be used.  NOTE:  The birthday 
graphics require the "Kids" multimedia set to be selected on the "Lane Settings" menu. 

15. Select the "Start" button to issue the lane.  If an autostop option was selected, the payment page 
may automatically be displayed at this point, if the "Charge Immediately For Payment" option 
was selected on the Settings page.  If the payment page is not displayed automatically, the 
operator must remember to manually select the payment page and make the appropriate payment.  
Alternatively, the "Reserve" button can be selected and this would create a lane reservation using 
the information entered above.  See also "Reservations" for more information. 

DETAILS 

 
  
The "Lane" field is used to enter the lane numbers to be issued.  Lane numbers may be entered in a 
variety of ways.  For example:: 1; 1-2; 1-40; 1-8, 10; 1, 3, 5; and 1 3 5. 
  
The "Single Lane" and "Cross Lane" options control whether the lanes will be issued in a single lane 
(open play) mode or as a pair of lanes in cross lane mode.  When lanes are issued in single lane mode, all 
the frames of the game will be bowled on the same lane.  When lanes are issued in cross lane mode, the 
frames will alternate between the odd and even lanes of the pair.   
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The "Time" and "Frames" practice options control the type of practice to be issued with the selected 
lanes.  If "Time" is selected the number of minutes entered into the "Practice" field will be used for each 
lane of the range.  If "Frames" is selected the number of frames entered into the "Practice" field will be 
issued to each player at the time the lane is issued.  Practice will be displayed on the automatic scorer.  
Practice frames and time is always accounted for.  There are many ways to charge for practice frames or 
time.  Frame practice can be charged at a rate of 10% of the regular bowling rate or a special frame 
practice article can be created with its own price.  Time practice can be charged at a rate of 1/60th of the 
price per hour or a special time practice article can be created with its own price.  If no practice is desired, 
set the "Practice" field to zero. 
  
The "Automatic Lanestop" option controls whether or not the lanes will turn off automatically.  If "Time" 
is selected the lanes will turn off automatically at the end of the number of minutes entered.  If "Games" 
is selected the lanes will turn off at the end of the number of games entered.  Typically Automatic 
Lanestop is used for prepaid bowling activities, and the payment page will automatically be displayed 
when a lane or lane range is issued.  This allows for the payment to be made prior to bowling.  However, 
the system is capable of turning lanes off automatically at the end of a set time or number of games, but 
taking payment after the bowling activity.  This can be useful for party activity.  The negative aspect of 
this type of payment is that the employee must remember to take the payment. 
  
The "Lane" drop down menu in the "Names" section is used to control which lane's bowler names are 
being displayed in the "Name's" section.  This allows names to be entered for each lane of a multi-lane 
transaction.  If a single lane is being issued, the drop down menu will only list the single lane. 
  
The "Number of Players" field is used to control the number of names that is initially being issued to the 
lane.  This is critical for the calculation of the number of practice games, as well as the total number of 
games being initially issued to a lane when "Automatic Lanestop" is selected. 
  
The "Birthday" option controls whether or not the special birthday exciter graphics will be used for this 
lane transaction.  If the box is checked, the special birthday exciter graphics will be used.  If the box is 
unchecked the standard graphics will be used.   
 
Note: The birthday graphics require the "Kids" multimedia set to be selected on the "Lane Settings" page. 
  
The "Names" fields are used to enter the bowlers name for this lane transaction.  The default names of 
"Player1", "Player2" and so on can be used, or the bowler's real name can be entered manually.  
Additionally, if the bowler is a member of the membership database, the plus key (+) on the keyboard can 
be used to open the search tool of the database so that a name can be looked up.  Also, the bowler's 
membership number can be typed into the name field and the system will automatically display the 
bowler's name.  Finally the bar code card could be scanned by the optional bar code scanner.   
 
Note: In order for the system to track bowler statistics, the name of the bowler must be entered from the 
database, by number or by scanning the card. 
  
The "Mode" drop down menus are used to select the type of bowling for each bowler.  The following 
bowling types are available: 
! Normal:  When this mode is selected regulation ten pin bowling will be played. 
! Notap 9:  When this mode is selected, the system will score nine or ten pins bowled over as a 

strike. 
! Notap 8:  When this mode is selected, the system will score eight, nine or ten pins bowled over as 

a strike. 
! Notap 7:  When this mode is selected, the system will score seven, eight, nine or ten pins bowled 
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over as a strike. 
! Notap 6:  When this mode is selected, the system will score six, seven, eight, nine or ten pins 

bowled over as a strike. 
! 369:  When this mode is selected the bowler will be awarded with an automatic strike in the third, 

sixth and ninth frames of each game, without bowling those frames. 
! 369 + NT9:  When this mode is selected the system will combined Notap 9 with 369. 
! 369 + NT8:  When this mode is selected the system will combined Notap 8 with 369. 
! 369 + NT7:  When this mode is selected the system will combined Notap 7 with 369. 
! 369 + NT6:  When this mode is selected the system will combined Notap 6 with 369. 

 
The "Price Rate" drop down menus are used to select the bowling rate for each bowler.  The system will 
automatically select the proper rate for the day and time of bowling, but the operator may select another 
rate, if permitted by system settings.  The operator can also change the rate on the payment page. 
  
The "Bumper" option is used to control whether or not each bowler will receive bumpers if the center is 
equipped with Brunswick automated bumpers. 
  
The "Reserve" button is used to make a reservation based upon the open play information entered.  See 
also "Reservations" 
  
Red Head Pin Configuration 

 
 
Rules Section 
The "Number of Games to Be Played" field is used to control the number of games in a lane transaction 
that will use the Red Head Pin game.  For example, if the number is set to three, the first three games of 
the lane transaction will use the Red Head Pin game.  If more than three games are bowled, the Red Head 
Pin game is not used.  This setting works in conjunction with the "Number of Red Head Pins Per Bowler" 
field detailed below. 
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The "Number of Red Head Pins Per Bowler" field is used to control the number of times each bowler will 
receive a Red Head Pin chance during the number of games specified in the "Number of Games to Be 
Played" field detailed above.  Each bowler will receive exactly the number of Red Head Pin chances 
within the number of games specified.  The location of the Red Head Pin chances for each bowler is 
randomized, but each player will receive the same quantity of chances in the specified number of games.  
If more games are bowled than specified, no additional Red Head Pin chances will occur. 
  
The "Default Rate" drop down menu is used to select the article to be used when issuing Red Head Pin 
lanes. 
  
The "Display Red Head Pin wins in the bowling payment area of the POS" controls whether or not the 
bowlers that bowl a strike when a Red Head Pin is present will be listed in the Lane Transaction section 
on the Payment page of the Point of Sale (POS) terminal.  Red Head Pin winners can be seen by selecting 
the "Bonus" tab.  When the "Bonus" tab is selected a bowler can be selected from the list and a Red Head 
Pin coupon can be printed based upon the coupon setting detailed below. 
  
The "Article Used For Wins" drop down menu is used to select which article is awarded as a prize for a 
winning Red Head Pin attempt on the coupon, if coupons are enabled below. 
  
Coupon Section 
The "Use Coupons" option controls whether or not the system will produce printed coupons for Red Head 
Pin wins.  If coupons are printed, the "Image Used On Coupon" field is used to select the bitmap graphic 
that is printed as a header on the coupon.  The graphic could be the normal receipt graphic that is used for 
all receipts, or a special Red Head Pin win graphic can be created.  The default Red Head Pin coupon 
graphic is a 288 by 128 pixel 256 color bitmap graphic named RHP.bmp that is stored in the 
C:\Brunswick\Reception directory.  This graphic can be used or a customized graphic can be used in it's 
place. 
  
The "Coupon Will Be Valid For x Days" field is used to control the number of days the coupon will be 
valid.  Select the desired number in this field. 
  
The "Text Used On Coupon" field is used for entering text that will print on the Red Head Pin coupon. 
  
Messages Section 
The "Prepare Bowler" message is used to inform the bowler that they have a Red Head Pin chance.  This 
message will be displayed when the red pin is in the head pin position. 
  
The "Strike Message" is used to inform the bowler of the results of bowling a strike when a red pin is 
present in the head pin position.  This message may simply congratulate the bowler, or may inform them 
to collect their prize at the front desk. 
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Waiting List (F9)Waiting List (F9)Waiting List (F9)Waiting List (F9)    
OVERVIEW 
This function is used to track customers that are waiting for lanes.  The waiting list tracks the name of the 
party and the time the party went on to the waiting list.  The entry for each customer may include the 
names of the bowlers which will be automatically be downloaded to the scorer. 
  
PROCEDURES 
Adding Parties To the Waiting List 

1. Select the "Rental" menu. 
2. Select the "Waiting List" menu item. 
3. Select the "Company Name" field and enter the name of the party. 
4. Select the "Players" field and enter the number of bowlers in the party, if desired. 
5. Select the "Name" fields and enter the names of the bowlers in the party, if desired. 
6. Select the "Add" button. 

 
Deleting Parties On the Waiting List 

1. Select the "Rental" menu. 
2. Select the "Waiting List" menu item. 
3. Select the party on the list to be deleted. 
4. Select the "Remove" button. 

 
Issuing Lanes From The Waiting List 

1. Select the "Rental" menu. 
2. Select the "Waiting List" menu item. 
3. Select the party on the list to be issued. 
4. Using the "Lane" drop down menu in the Open Play section, select an available lane. 
5. Select the "Start" button. 

 
DETAILS 

 
  
The "Company Name" field is used to enter the name of the 
party that is waiting.  Typically the name that is used is the name 
that is used to contact the customer when the lane is available. 
  
The "Players" field is used to control the number of bowler 
names on the lane.  The player name fields are used to enter the 
names of the players on the waiting list.  Using this function can 
significantly reduce the amount of time it takes for customers to 
get started and will increase the number of lane turnovers. 
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ReservationsReservationsReservationsReservations    
OVERVIEW 
This function is used to track reservations for bowling lanes.  Reservations can be made for a single lane 
or a range of lanes.  Reservations can be color coded and track a variety of information. 
  
PROCEDURES 
Making A Reservation 

1. Using the mouse or the touch screen, point to the starting time of the reservation on the desired 
lane or first lane of a lane range. 

2. Drag the pointer to the ending time on the desired lane or the last lane of a lane range.  When the 
mouse button is released or the finger lifted from the touch screen, the reservation dialog box will 
be automatically displayed. 

3. Select the "Name" field and enter the name of the party reserving the lane or lane range. 
4. Select the "Remark" field and enter comments that should be viewed on the lane status page when 

the operator right clicks the reservation, if desired. 
5. Select the "Phone" field and enter the telephone number of the party reserving the lane or lane 

range, if desired. 
6. Select the "Fax" field and enter the fax number of the party reserving the lane or lane range, if 

desired. 
7. Select the "Address" field and enter the address of the party reserving the lane or lane range, if 

desired. 
8. To change the color code for this reservation, select the "Details" button and then click on the 

color code in the lower right corner.  Select the new color code for this reservation and select the 
"OK" button. 

9. To enter detailed information about this reservation, select the "Details" button and enter the text 
in the details field, then select the "OK" button. 

10. If the reservation is to repeat, select the "Standing Until" option and enter the ending date of the 
reservation. 

11. Select the "OK" button to complete the reservation. 
 
Changing A Reservation 

1. Select the "Change" menu. 
2. Select the "Reservation" menu item. 
3. Select the desired reservation and select the "OK" button. 
4. Make desired changes. 
5. Select the "OK" button. 

or 
1. Right click on the desired reservation displayed on the Lane Status page. 
2. Select the "Properties" menu item from the pop-up menu. 
3. Make desired changes. 
4. Select the "OK" button. 

 
Deleting A Reservation 

1. Right click on the desired reservation displayed on the Lane Status page. 
2. Select the "Delete" menu item from the pop-up menu. 
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3. Select the "Yes" button. 
 
DETAILS 

 
  
The "Date" field is used to control the date of the reservation.  The date is automatically entered based 
upon the date visible on the Lane Status page when the reservation is created.  Alternatively the date can 
be manually entered for a reservation on any date. 
  
The "Start" field is used to control the start time of the reservation.  The start time is automatically entered 
based upon the time selected when the reservation was made.  Alternatively the start time can be entered 
manually. 
  
The "End" field is used to control the end time of the reservation.  The end time is automatically entered 
based upon the time selected when the reservation was made.  Alternatively the end time can be entered 
manually. 
  
Note: The start and end times entered into the system are for reservation purposes only.  They have no 
effect on the payment for the transaction. 
  
The "Name" field is used to enter the name of the party making the reservation.  This name is displayed 
on the lane status page.  The name may be displayed completely or only as initials based on the setting on 
the "Front Desk" tab of the system setup. 
  
The "Remark" field is used to enter brief remarks that can be displayed by right clicking on the 
reservation from the lane status page. 
  
The "Standing Until" option is used automatically make the same reservation until the selected date.  This 
is typically used for events that repeat weekly. 
  
The "Phone" field is used to enter the telephone number of the party making the reservation.  The "Fax" 
field is used to enter the fax number of the party making there reservation.  The "Address" field is used to 
enter the mailing address of the party making the reservation. 
  
The "Details" button is used to open a window that allows extensive comments to be entered.   
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The operator may also change the color code for this reservation by clicking on the color displayed in the 
"Color Code" box of the details dialog box and the following color selection menu will be displayed: 
  

 
  
The operator may select from one of the "Basic Colors" listed or may select a color from the color palate.  
Colors selected from the palate may be added to the "Custom Colors" list for future selection.  Colors 
may also be constructed by entering the desired values in the "Hue, Sat, Lum, Red, Green and Blue" 
fields. 
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Correcting ScoresCorrecting ScoresCorrecting ScoresCorrecting Scores    
OVERVIEW 
This function is used to remotely change bowler, team or score information. 
  
PROCEDURES 
Correcting Scores 

1. Select the "Change" menu. 
2. Select the "Correct Scores" menu item. 
3. Using the "Lane" drop down menu, select the desired lane. 
4. Make desired changes. 
5. Select the "OK" button. 

 
DETAILS 

 
  
The "Lane" drop down menu is used to select which lane's information is being displayed and corrected. 
  
The "Team Name" field is used to enter or change the team's name during league or tournament 
competition.  This information can also be entered when starting league lanes.  However, the correct 
scores function is the only place in the system where a change to the team name can be made. 
  
The "Team Hcp" field is used to enter the single total team handicap for this team.  This is not the sum of 
the individual bowler handicaps, but another team handicap method, typically the sum of the individual 
bowler averages.  The correct scores function is the only place in the system where a change to the team 
handicap can be made. 
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The "Cross Lane Mode" option is used to control whether the selected lane is in cross lane or single lane 
mode. When this option is selected frames for this pair of lanes will be bowled on alternating lanes.  For 
example, the odd frames will be bowled on the odd lane and the even frames will be bowled on the even 
lane.  When this option is not selected all frames will be bowled on the same lane.   
 
Note:  This option will affect the current game in progress. 
  
The "Skip" option is used to temporarily remove a bowler from the lineup during bowling.  A skipped 
bowler is not removed from the scoresheet, but will not be scheduled to bowl until the bowler is manually 
"unskipped".  This function is typically used when a bowler will be unavailable to bowl their turn for 
several frames. 
  
The "BW" option is used to control whether or not the automated bumpers will raise for the bowler.  If 
this option is selected the bumpers will be raised for the selected bowler.  If this option is not selected the 
bumpers will remain lowered for the selected bowler.  The bowler can also enable bumpers at the scorer 
console by placing "+C" after the bowler's name. 
  
The "-A-" displayed in front of a bowler's name indicates that bowler is currently up to bowl. 
  
The "Name" fields are used to enter or change the bowler's names. 
  
The "Bowler Type" drop down menu is used to select the bowler type for the selected bowler.  The 
following bowler types are available: 
! Regular - A regular member of a league team. 
! Substitute - A member of a league or team that is replacing a regular bowler temporarily. 
! Absent - This is used when a regular bowler is absent and a substitute bowler is not being used. A 

score will be used by the team for computing wins and losses but no score will be awarded to the 
bowler.  Typically this score is the bowler's average minus a penalty.  The league rules determine 
the actual values. 

! Vacant - This is used when team is permanently missing regular members.  The league will 
stipulate the value to be used to calculate team wins and losses. 

! Pacer - This is used when an additional bowler will bowl to keep the teams pace even, but the 
team totals will not include the pacer's scores.  Instead the team's wins and losses will be 
calculated using the absent score for the missing player. 

 
The first and second ball fields for each frame are used to enter the score of each ball bowled.  The score 
for a ball can be directly changed.  The grayed out fields have not yet been bowled, but the "+" button at 
the end of the bowler's game can be used to add a frame. 
  
The "Ave", "HCP", "Abs." and "Vac" fields are used to enter the bowler's average, handicap, absentee 
score and vacancy score, respectively.  The "SER" field displays the total number of pins bowled down 
by this bowler for the current match. 
  
The "Mode" drop down menu is used to select the bowling game in use for each player.  The following 
games are available: 
! Normal - Regular ten pin bowling. 
! Notap 9 - Regular ten pin bowling plus bowling nine pins over will be scored as a strike. 
! Notap 8 - Regular ten pin bowling plus bowling nine or eight pins over will be scored as a strike. 
! Notap 7 - Regular ten pin bowling plus bowling nine, eight or seven pins over will be scored as a 

strike. 
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! Notap 6 - Regular ten pin bowling plus bowling nine, eight, seven or six pins over will be scored 
as a strike. 

! 369 - Regular ten pin bowling plus an automatic strike in the third, sixth and ninth frames. 
! 369 + NT9 - Combination of 369 and Notap 9. 
! 369 + NT8 - Combination of 369 and Notap 8. 
! 369 + NT7 - Combination of 369 and Notap 7. 
! 369 + NT6 - Combination of 369 and Notap 6. 

 
The "Active Player" button is used to select the current bowler.  The following dialog box is displayed: 
  

 
  
Select the desired player and then select the "OK" button. 
  
The "Remove Last Ball" button is used to remove the last ball (not frame) bowled. 
  
The "Add Ball" button is used to add a ball score to the current bowler. 
  
The "Add Player" button is used to add a bowler name to the score sheet.  Once this button is selected a 
new player will be added to the scoresheet.  The operator may then change the name of the player in the 
"Name" field. 
  
The "Remove Player" button is used to remove a bowler name from the score sheet.  Once this button is 
selected a dialog box will be displayed to select which bowler is to be removed.  This will remove the 
bowler's name and scores from the scoresheet, but will not change the total amount due for this lane. 
  
The "Reorder Players" button is used to change the order in which the bowlers will bowl.  The following 
dialog box will be displayed: 
  

 
  
Select the bowler to be moved and use the "Up" and "Down" buttons to place the bowler's name in the 
desired location on the scoresheet.  If this process is done during bowling all scores will move with the 
bowler's name. 
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Changing Autostop PaChanging Autostop PaChanging Autostop PaChanging Autostop Parametersrametersrametersrameters    
OVERVIEW 
A lane in autostop mode will turn off automatically at the end of the amount of time or games sold in 
advance.  This function is used to increase or decrease the amount of time or games sold to a lane. 
  
PROCEDURES 
Extending Autostop Quantities 

1. Select the "Change" menu. 
2. Select the "Change Autostop Parameters" menu item. 
3. Select the "Lane" field and enter the lane or lane range to be changed. 
4. Select the appropriate time or game bowling change field. 
5. Enter the amount of time or games to be added to the lane. 
6. Select the "OK" field. 
7. Make any necessary payments for the additional time or games. 

 
Reducing Autostop Quantities 

1. Select the "Change" menu. 
2. Select the "Change Autostop Parameters" menu item. 
3. Select the "Lane" field and enter the lane or lane range to be changed. 
4. Select the appropriate time or game bowling change field. 
5. Enter the amount of time or games to be subtracted from the lane.  Note: Be sure to enter a 

negative quantity by placing a "-" sign in front of the number.  For example "-5". 
6. Select the "OK" field. 
7. Make any necessary refund payments for the reduced quantity of time or games. 

 
DETAILS 

 
The "Lanes" field is used to control the lane or lane range that will be 
controlled by the practice settings. 
  
The "Automatic Lanestop" option is used to control whether or not the 
selected lane or lane range will automatically stop at the end of the 
amount of time or games sold.  When this option is enabled, the lane will 
turn off at the end of the amount of time or games sold.  If this option is 
not selected, the lane will remain on until manually turned off. 

  
An autostop lane can be controlled by an amount of time or a number of games.  If the "Time" radio 
button is selected the lane will turn off automatically at the end of the time remaining.  The amount of 
time can be increased or decreased by selecting the "Change" field and entering a positive amount of time 
to increase or a negative amount of time to decrease. 
  
If the "Game" radio button is selected the lane will turn off automatically when the number of frames 
remaining have been bowled.  The number of frames can be increased or decreased by selecting the 
"Change" field and entering a positive quantity of frames to increase or a negative quantity of frames to 
decrease. 



 109

Recovering LanesRecovering LanesRecovering LanesRecovering Lanes    
OVERVIEW 
This function is used to restore lanes that were accidentally turned off or when prepaid bowling has 
expired and the bowlers would like to bowl more. 
  
PROCEDURES 
Recovering A Lane 

1. Select the "Change" menu. 
2. Select the "Recover Lane..." menu item. 
3. Select the lane to be recovered. 
4. Select the "OK" button. 

 
Recovering A Lane After A Hardware Failure 

1. Correct the failed hardware. 
2. Select the "Change" menu. 
3. Select the "Recover Lane..." menu item. 
4. Select the lane to be recovered. 
5. Select the "Use Front Desk Backup" option. 
6. Select the "OK" button. 

 
DETAILS 

 
  
The list box displays all the lanes in the center.  More than one lane can be selected for recovery by 
pressing the "CTRL" key on the keyboard, or a range of lanes may be selected by holding down the shift 
key when selecting the first and last lane. 
  
The "Use Front Desk Backup" option is used to restore scoresheet information from the backup made to 
the front desk server computer, instead of using the scoresheet information stored on the lane server 
computer.  The scoresheet information is backed up from the lane server computer to the front desk server 
at a rate of two seconds per lane.  This means that if there are 30 lanes in the center, every minute all of 
the scores in the center will be backed up to the front desk server.  This feature can then be used to restore 
scoresheet information to recover a lane after a hardware failure, such as crashed hard drive, in the lane 
server computer. 
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Changing Lane Status ViewsChanging Lane Status ViewsChanging Lane Status ViewsChanging Lane Status Views    
OVERVIEW 
This function is used to control the number of lanes in view on the lane status page.  There are three 
different views available. 
  
PROCEDURES 
Changing the Lane Status View 

1. Select the "View" menu. 
2. Select the desired view. 

 
DETAILS 
The following three views are available: 
! Zoom 1:1 - This option will display all the lanes in the center on the lane status display. 
! Zoom 1:2 - This option will display one half of the lanes in the center on the lane status display.  

To view the other lanes scroll bars are added to the display. 
! Zoom 1:3 - This option will display one third of the lanes in the center on the lane status display.  

To view the other lanes scroll bars are added to the display. 
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Turning Off Lanes (ESC)Turning Off Lanes (ESC)Turning Off Lanes (ESC)Turning Off Lanes (ESC)    
OVERVIEW 
This function is used to turn off a range of lanes. 
  
PROCEDURES 
Turning Off Multiple Lanes 

1. Select the "Rental" menu. 
2. Select the "Stop Lanes" menu item. 
3. Select the "Lanes" field and enter the lane or lane range to be turned off. 
4. Select the "OK" button. 

or 
1. Select the "ESC" button on the keyboard or the "Stop" button on the lane status display. 
2. Select the "Lanes" field and enter the lane or lane range to be turned off. 
3. Select the "OK" button. 

 
Pinsetter Emergency Off 

1. Select the "ESC" button on the keyboard or the "Stop" button on the lane status display. 
2. Select the "Lanes" field and enter the lane or lane range to be turned off. 
3. Select the "Emergency Off" button. 

 
Note: When emergency off is used for a single lane, a pair of lanes or a range of lanes, all equipment 
shared by the lanes on each pair will be turned off.  In the case of Brunswick A, A2 and GS series 
pinsetters, this will happen immediately.  In the case of AMF pinspotters there will be a delay of 
approximately thirty seconds before the pinspotters and associated equipment such as the ball lift, will be 
turned off. 
  
DETAILS 

 
  
The "Lanes" field is used to select which lanes will be turned off.  Lanes can be entered in a variety of 
formats, such as: 1-8; 1, 3, 5; 1-4, 8; or 1 3 5. 
  
The "..." or browse button displays the following dialog box: 
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The "Lanes" field is used to select which lanes will be turned off.  Lanes can be entered in a variety of 
formats, such as: 1-8; 1, 3, 5; 1-4, 8; or 1 3 5. 
  
The display window can be used to select lanes by clicking them with the mouse or touching them if a 
touch screen monitor is in use.  The "Icons" and "List" buttons are used to control the appearance of the 
lanes listed in the display window. 
  
The "Filter" section is used to control which lanes appear in the display window.  The following filter 
options are available: 
  
Assignment Status: 
! Assigned - When this option is selected only lanes that are issued to customers will be listed. 
! Free - When this option is selected only lanes that are available will be listed. 
! All - When this option is selected both assigned and free lanes will be listed. 

 
Game Types 
! Open - When this option is selected only lanes issued in the open play or cross lane open play 

modes will be listed. 
! League - When this option is selected only lanes issued in league practice or league competition 

will be listed. 
! Tournament - When this option is selected only lanes issued in tournament practice or tournament 

competition will be listed. 
! Red Pin - When this option is selected only lanes issued with the red head pin game will be listed. 
! Other - This option is reserved for future use. 

 
Hold Status 
! Only On Hold - When this option is selected only lanes that are on hold will be listed. 
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ChangiChangiChangiChanging Practiceng Practiceng Practiceng Practice    
OVERVIEW 
This function is used to control the amount and type of practice bowling for a lane.  Practice can be added 
to a lane that has been issued without practice or the amount or type of practice on a lane can be changed. 
  
PROCEDURES 
Changing Practice 

1. Select the "Change" menu. 
2. Select the "Practice" menu item. 
3. Select the "Lane" field and enter the desired lane or lane range. 
4. Select from one of the following practice types: 
! Time - Practice by time. 
! Frames - Practice by frame. 
! None - No practice. 

5. Select the amount field and enter the quantity of practice. 
6. Select the "OK" button. 

 
DETAILS 

 
  
The "Lanes" field is used to control the lane or lane range that will be controlled by the practice settings. 
  
The "Amount" field is used to control the quantity of practice minutes or frames issued to a lane. 
  
The following three practice options are available: 
! Time - Practice by minute.  The total number of minutes of practice is displayed on the overhead 

monitor and counts down by the second until the practice is completed.   
! Frames - Practice by frames.  The total number of frames of practice is displayed on the overhead 

monitor and counts down by frame until the practice is completed.   
! None - No practice.  The practice mode for the selected lane or lane range is turned off. 

 
At the end of the practice time a graphic and a sound file will be played to indicate the end of practice. 
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Payment (F4Payment (F4Payment (F4Payment (F4))))    
OVERVIEW 
This function is used to ring up items that are sold in the bowling center.   
  
PROCEDURES 
Ringing Up A Bowling Sale 

1. In the "Bowling Payment" section, select the desired lane transactions.  More than one transaction 
can be selected.  As transactions are selected the bowling rate information is automatically 
displayed in the receipt section below the "Bowling Payment" section. 

2. If necessary, make adjustments to articles to deal with different rates, free bowling and so on. 
3. If additional articles are to be sold, select the desired products using one of the following options: 
! Select the "Article Number" field and type the desired article's number. 
! Select the "Name" drop down menu and select the desired article from the list. 
! Select the desired "Article Group" and then the desired article on the list of article buttons 

displayed with a blue background. 
! If articles have been assigned to function keys, press the desired function key (F1-F12) on the 

keyboard, or select the "Function Keys" button and select the desired article on the list of 
function key buttons displayed with a blue background. 

! If the system is equipped with a bar code scanner, it is also possible to scan the Universal 
Product Code (UPC), if the UPC number is the number of the article.  If an article doesn't 
have its own UPC it is possible to print "Barcodes For Articles" report that generates a bar 
code for the selected articles. 

4. If necessary, for each product select the "Price" field and enter the price of the item being sold. 
5. If necessary, for each product select the "Qty." field and enter the quantity of the item being sold. 
6. Use the "Clerk" drop down menu to select the clerk ringing up this sale.  If a clerk ID code was 

required to access the payment screen this step is not necessary. 
7. Use the "Method" drop down menu to select the payment method for this sale, or select the 

"Method" button and select the button for the desired payment method. 
8. Use the "Print Receipt" button to control whether or not a receipt will be printed for this 

transaction.  If the "Print Receipt" button appears 'pushed in' and a lighter grey than the other 
buttons a receipt will be printed. 

9. Select the "Subtotal" button to complete the sale. 
10. If desired, select the "Money From Client" field and enter the amount tendered by the customer.  

This will cause the system to calculate the amount of change to be returned. 
11. Select the "OK" button. 
12. If the Frequent Bowler Program (FBP) is enabled, follow the following steps to register the 

customer's activity: 
! Select the "Card/Member Number" field and use one of the following options to select the 

correct bowler from the database: 
! Type the bowler's membership database number. 
! Scan the bowler's bar code card. 
! Select the "Pick" button and select the customer by name from the database. 

! Select the "Register" button.  Note:  If the amount of money, time or games displayed in the 
FBP registration menu is to be divided among multiple bowlers, manually change the amount 
to be credited to the first customer.  The FBP registration menu will remain available until 
the total amount has been registered or the "Cancel" key is selected. 



 115

Ringing Up A Non-Bowling Sale 
1. Select the desired products using one of the following options: 
! Select the "Article Number" field and type the desired article's number. 
! Select the "Name" drop down menu and select the desired article from the list. 
! Select the desired "Article Group" and then the desired article on the list of article buttons 

displayed with a blue background. 
! If articles have been assigned to function keys, press the desired function key (F1-F12) on the 

keyboard, or select the "Function Keys" button and select the desired article on the list of 
function key buttons displayed with a blue background. 

! If the system is equipped with a bar code scanner, it is also possible to scan the Universal 
Product Code (UPC), if the UPC number is the number of the article.  If an article doesn't 
have its own UPC it is possible to print "Barcodes For Articles" report that generates a bar 
code for the selected articles. 

2. If necessary, for each product select the "Price" field and enter the price of the item being sold. 
3. If necessary, for each product select the "Qty." field and enter the quantity of the item being sold. 
4. Use the "Clerk" drop down menu to select the clerk ringing up this sale.  If a clerk ID code was 

required to access the payment screen this step is not necessary. 
5. Use the "Method" drop down menu to select the payment method for this sale, or select the 

"Method" button and select the button for the desired payment method. 
6. Use the "Print Receipt" button to control whether or not a receipt will be printed for this 

transaction.  If the "Print Receipt" button appears 'pushed in' and a lighter grey than the other 
buttons a receipt will be printed. 

7. Select the "Subtotal" button to complete the sale. 
8. If desired, select the "Money From Client" field and enter the amount tendered by the customer.  

This will cause the system to calculate the amount of change to be returned. 
9. Select the "OK" button. 
10. If the Frequent Bowler Program (FBP) is enabled, follow the following steps to register the 

customer's activity: 
! Select the "Card/Member Number" field and use one of the following options to select the 

correct bowler from the database: 
! Type the bowler's membership database number. 
! Scan the bowler's bar code card. 
! Select the "Pick" button and select the customer by name from the database. 

! Select the "Register" button.  Note:  If the amount of money, time or games displayed in the 
FBP registration menu is to be divided among multiple bowlers, manually change the amount 
to be credited to the first customer.  The FBP registration menu will remain available until 
the total amount has been registered or the "Cancel" key is selected. 

 
Reprinting A Receipt 

1. In the "Transactions" section, use the up and down arrow buttons to highlight the desired receipt. 
2. Select the "Receipt" button. 

 
Voiding an Item From A Pending Transaction 

1. Select one of the following methods: 
! Select the "Article #" field of the desired item and delete the article number from the field. 
! Select the "Name" drop down menu and select "(No Product)". 
! Use the up and down arrows to move the green box to the desired item and select the "Void" 

button. 



 116

Making A Refund 
1. Select the "Refund" button.   
2. Enter a password, if required and select the "OK" button. 
3. Select the desired products using one of the following options: 
! Select the "Article Number" field and type the desired article's number. 
! Select the "Name" drop down menu and select the desired article from the list. 
! Select the desired "Article Group" and then the desired article on the list of article buttons 

displayed with a blue background. 
! If articles have been assigned to function keys, press the desired function key (F1-F12) on the 

keyboard, or select the "Function Keys" button and select the desired article on the list of 
function key buttons displayed with a blue background. 

! If the system is equipped with a bar code scanner, it is also possible to scan the Universal 
Product Code (UPC), if the UPC number is the number of the article.  If an article doesn't 
have its own UPC it is possible to print "Barcodes For Articles" report that generates a bar 
code for the selected articles. 

4. If necessary, for each product select the "Price" field and enter the price of the item being 
refunded. 

5. If necessary, for each product select the "Qty." field and enter the quantity of the item being 
refunded. 

6. Use the "Clerk" drop down menu to select the clerk ringing up this sale.  If a clerk ID code was 
required to access the payment screen this step is not necessary. 

7. Use the "Method" drop down menu to select the payment method for this sale, or select the 
"Method" button and select the button for the desired payment method. 

8. Use the "Print Receipt" button to control whether or not a receipt will be printed for this 
transaction.  If the "Print Receipt" button appears 'pushed in' and a lighter grey than the other 
buttons a receipt will be printed. 

9. Select the "Subtotal" button to complete the sale. 
10. If desired, select the "Money From Client" field and enter the amount tendered by the customer.  

This will cause the system to calculate the amount of change to be returned. 
11. Select the "OK" button. 
12. Enter a valid reason for the refund and select the "OK" button. 
13. If the Frequent Bowler Program (FBP) is enabled, follow the following steps to register the 

customer's refund activity: 
! Select the "Card/Member Number" field and use one of the following options to select the 

correct bowler from the database: 
! Type the bowler's membership database number. 
! Scan the bowler's bar code card. 
! Select the "Pick" button and select the customer by name from the database. 

! Select the "Register" button.  Note:  If the amount of money, time or games displayed in the 
FBP registration menu is to be divided among multiple bowlers, manually change the amount 
to be credited to the first customer.  The FBP registration menu will remain available until 
the total amount has been registered or the "Cancel" key is selected. 

 
Open The Cash Drawer For A No Sale Transaction 

1. Select the "Open Drawer Button. 
 
Printing A Shift Report 

1. Select the "File" menu. 
2. Select the "Print Shift Report" menu item 



 117

3. Select the desired clerk 
4. Select the "Print" button. 
5. If necessary, select the desired printer and select the "Print" button. 

 
Printing Red Head Pin Prize Coupons 

1. Follow the first eight steps of "Ringing Up A Bowling Sale" detailed above, if desired. 
2. Select the "Bonus" tab in the "Bowling Payments" section. 
3. Select the desired Red Head Pin bowler. 
4. Select the "Subtotal" button. 
5. Select one of the following options: 
! "Do Payout Now" - This option uses the coupon as part of the current lane related transaction. 
! "Print Coupon" - This option prints out a numerically controlled coupon to be used on a 

subsequent visit to the center. 
6. If "Do Payout Now" was chosen, select the "OK" button to complete the sale. 

 
Redeeming Red Head Pin Prize Coupons 

1. Follow the first eight steps of "Ringing Up A Bowling Sale" detailed above, if desired. 
2. Select the "Coupon" button. 
3. Enter the coupon number and select the "OK" button. 
4. Select the "Subtotal" button. 
5. Select the "OK" button. 

DETAILS 
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The "Transactions" section displays the last ten minutes worth of transactions.  The up and down arrows 
can be used to select a receipt for reprinting by selecting the "Receipt" button. 
  
The "Bowling Payment" section displays a list of bowling transactions that have not been paid.  This list 
is used to select a lane transaction for payment.  Multiple transactions can be selected at the same time to 
combine different lanes into a single payment.  The "Bonus" tab displays pending Red Head Pin game 
winners which is used to print or redeem prizes.  The "Lanes" field is used to filter out a specific range of 
lanes for this payment terminal. 
  
The transaction section displays the current transaction.  The "Article #" field can be used to select an 
item for sale.  To remove an item from a sale the article number entered in this field can be deleted. 
  
The "Name" drop down menu can also be used to select an item for sale.  When using the "Name" drop 
down list the first letter of an article can be used to move the highlight bar to the first item beginning with 
the letter typed.  For example, if the letter "B" is pressed while the "Name" drop down menu is displayed 
the highlight bar will move to the first item in the list that starts with the letter "B".  If the letter "B" is 
pressed a second time the highlight bar moves to the second item in the list that starts with the letter "B" 
and so on.  To remove an article from a sale the "(No Product)" article can be selected. 
  
The "Price" field can be used to enter the price for a product with open pricing.  Typically this is used for 
products that have open pricing like vending machine income or bowling ball sales.  During these sales 
the employee enters the selling price of the article being rung up.  If this field is grey, the price cannot be 
modified.  If this field is white the price can be modified. 
 
The "Qty." field is used to enter the quantity of the article being sold. 
  
The "Total" field is calculated based upon the price multiplied by the quantity. 
  
The "Clerk" drop down menu is used to select the clerk that should be credited with this sale. 
  
The "Method" drop down menu is used to select the payment method used for this sale.  The following 
payment methods are available: 
! Cash 
! Check 
! Card 

 
The "Subtotal" button is used to complete the sale.  The "Print Receipt" button is used to toggle the 
receipt printing status.  If the button appears pushed in and a light grey then a receipt will be printed. 
  
The buttons with the blue background will display the "Function Keys" if the "Function Key" button is 
selected, or the buttons will display the articles if an "Article Group" is selected.  When a button is 
selected, that item or package will be rung up as part of the current transaction.  If there are more than 
twelve articles in a group, the left and right arrows can be used to scroll through the articles. 
  
The "Refund" button is used to make a negative transaction, such as a product return.  When a refund is 
made the employee will be asked for a reason code.  This reason code along with the transaction will be 
printed on the "Refund Report". 
  
The "Void" button is used to remove an item from the current sale.  Use the up and down arrows to move 
the green box to the article that is to be voided from the sale. 
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The "Function Key" button causes the buttons with the blue background to display the articles or 
packages assigned to the function keys (F1-F12). 
  
The "Article Groups" buttons are used to select a group of articles.  Once an article group is selected all 
the articles within that group will be displayed on the buttons with the blue background.  If there are more 
than ten article groups the left and right arrow buttons can be used to scroll through the groups. 
  
The numeric keypad can be used to enter article prices or quantities based upon which function is 
displayed on the button in the lower left corner.  If "QTY" is displayed numeric entries will change the 
quantity of the article.  If "Price" is displayed numeric entries will change the price of the article, if the 
article has an open price. 
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